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Getting Started 
Computer Requirements 
Installation & Setup 
Activation Password 
On-line Help 

 
Respondus is a powerful tool for creating and managing exams that can be printed to paper or 
published directly to WebCT, Blackboard, eCollege and other eLearning systems. Exams can be 
created offline using a familiar Windows environment, or moved from one eLearning system to 
another.  
 
Minimum Computer Requirements 
Respondus requires Windows 98 or higher, 32 MB of RAM, 6 MB of free hard disk space, and a 
800x600 monitor (1024x768 recommended). Respondus is generally used in conjunction with a 
course management system such as ANGEL, Blackboard, eCollege, WebCT, and can also be 
used with IMS QTI-compliant assessment systems. 
 
 
Installation and Setup 
The Respondus installation program can be downloaded from www.respondus.com. To begin the 
installation process, locate the Respondus3.exe file that was downloaded to your hard drive. 
Double-click the file to start the Respondus installation program and follow the instructions on 
the screen. Once Respondus is installed, start the program by double-clicking the Respondus icon 
that appears on the Windows desktop. Or, follow these steps to start the software. 
  
 Click [Start] from the Windows desktop 
 Click [Programs] 
 Click [Respondus] 
 Click [Respondus 3.0] 
 
The first time you start Respondus (and each time thereafter until the program is registered), you 
will be presented with a screen that provides the “Product ID#”. The Product ID# is used to 
obtain the Activation Password (see below) which is needed to complete the installation. 
 
 
Activation Password 
Once the Respondus installation program is finished, you will need to obtain a password from 
www.respondus.com to activate the installation. Be sure to have the “Product ID#” (see previous 
paragraph) readily available. After you have directed your browser to www.respondus.com, go to 
the “Registration” section of the site. You have the choice of purchasing a permanent activation 
password or obtaining a 30-day trial password. In both cases you will be required to enter a valid 
e-mail address and the Product ID# that displays on the opening screen of Respondus. Once the 
information is submitted, the activation password is immediately sent to the e-mail address you 
specified.  
 
When the password is received by e-mail, it must be entered into the Respondus program. If you 
haven’t done so already, start Respondus and then enter the password when prompted (you may 
want to “copy and paste” the password from the e-mail message in order to prevent typing 
mistakes). Click [OK] to continue. The Respondus software is now activated, either permanently 
or for a 30-day trial period.  
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Choose a Course Management System (CMS) Personality 
Immediately after the Respondus software is activated, you are prompted to select a Course 
Management System (CMS) “personality.” Respondus offers various user environments (called 
“personalities”) that parallel the features and terminology used by specific course management 
systems, such as Blackboard, eCollege and WebCT. You can change the “personality” at any 
time in Respondus from the Start menu.  
 
 
On-line Help 
Respondus includes a full-featured help system that includes an index and context-sensitive help. 
To view the on-line help, choose “Help Topics” from the pull-down Help menu and select a topic. 
You can also press the F1 key from within Respondus to obtain context-sensitive help. 
Throughout the program you will additionally see small buttons with a “?” symbol. When the 
button is clicked, information on that particular option or task is provided.  
 
If you encounter a question that is not answered in the on-line help or in this manual, you are 
encouraged to visit the “Support” section of our web site (www.respondus.com). There you will 
find Frequently Asked Questions (FAQ) and other resources.  
 
The remainder of this user manual is organized according to the five menus used in the “WebCT 
6 / Vista 4” personality of Respondus: Start, Edit, Settings, Preview & Publish, and Retrieval 
& Reports. 
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Start Menu 
Overview of Start Menu 
Opening a File 
Creating a File 
Importing Questions to Respondus 
Exam Wizard 
Archive Wizard 
Changing the CMS Personality and Converting Files 

 
 
Overview of Start Menu 
The Start menu provides the ability to Open a Respondus file, Create a new file, and Import 
questions from a text file. The Exam Wizard provides the easiest way to create an exam from an 
existing set of questions. The Archive Wizard allows you to archive an exam or survey, 
including all media components and equations, with a single click.  
 
A Respondus file must be open before you can go to another menu in Respondus. 
 
 
Opening a File 
From the Start menu, click the Open button. The following window will appear: 
 

 
 
Highlight an exam or survey “project” by clicking it once. To obtain information on the project, 
select one of the two center buttons located to the top right of the window. Select the “Item List” 
button (right of center) to view a list of the questions that are available in the highlighted project. 
To preview a particular question, click the “Title” of the question.  
 
To open a highlighted project, click the [Open] button at the bottom of the window. (Double-
clicking a file name will also open it.)  
 
Respondus allows projects to be organized within folders. For example, you can place the exams 
for a particular course within a folder rather than having exams for all courses listed together. To 
create a new folder, click the “Create New Folder” button located second from left. To navigate 
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down a level within a folder, double-click on the folder itself. To navigate up a level, click the 
“Up One Level” button located leftmost on the row of buttons.  
 
The [Browse…] button, located on the lower left side of the window, allows you to locate a 
Respondus file (.rsp) located elsewhere on your hard drive and copy the file to the Respondus 
Projects folder. It does not move the file or open it directly, rather, it creates a new “Projects” 
folder based on a copy of that file. The [Browse…] button can also be used to locate a Respondus 
“archive” file (.rsa or .rpa) and to restore it to the Projects directory (see Restoring an Archive 
File). 
 
The [Search] button allows a file to be searched prior to opening it (it can only be used if the 
“Item List” view is selected). Searching is particularly useful if you are trying to locate a 
particular question or set of questions in a file.  
 
The [Download Test Bank] button is used to download test banks that are distributed by 
textbook publishers. Hundreds of the leading textbooks for higher education have test banks 
available in Respondus format. These can be downloaded via the Internet with the Respondus 
software. (For complete details, see the “Respondus Test Bank Network” at 
www.respondus.com.)  To download a test bank, enter the File Code and password that is 
supplied by the publisher. Respondus will automatically locate, download, and restore the test 
bank file and place it in the Respondus Projects folder.  
 
Once a file is opened, the screen automatically changes to the Edit menu.  
 
 
Creating a File 
From the Start menu, select the Create button to create a new file. You are first prompted to enter 
a file name and a description for the file. Then you must indicate whether the file is an “Exam” or 
a “Survey.” The type of file you create (or open) will determine the features that are available 
throughout the program. Click [OK] when you are finished. Once a file is created, you are 
automatically switched to the Edit menu. This is where you add questions to the file. 
 
 
Importing Questions 
Respondus allows you to import multiple choice, true-false, paragraph, short answer, matching, 
and multiple response questions from a file. The questions must be organized in a format that is 
acceptable to Respondus and the file must be stored in text (.txt) or rich-text (.rtf) format. (All 
word processors have the capability of saving files to .txt or .rtf format--so does the WordPad 
application in Windows.) 
 
The formatting required for the file being imported is discussed in the section below entitled “The 
Standard Format for Importing.” Once the file is in the Standard Format, follow these steps to 
import it into Respondus.  
 
Starting the Import 
From the Start menu, select the [Import Questions] task. The following dialog will appear: 
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Step 1 
The first step is to select the type of file that will be imported. The “Standard Format” for 
organizing questions is the same for Plain Text (.txt), Rich Text (.rtf) files, and Microsoft Word 
(.doc) files. Files that are in rich text (.rtf) and MS Word (.doc) format will retain some of the 
enhanced question formatting such as bold, italic, underline, superscript, and subscript. 
Embedded graphics can only be imported if the file is in Microsoft Word (.doc) format, although 
an alternative method is available for .rtf and .txt files (see Importing Images below). Note that 
certain types of enhanced importing cannot be imported. If the enhanced formatting causes a 
problem with an import, consider saving the file to rich text or plain text format and then try the 
import again.  
 
Next, use the [Browse] button to locate and select the file to be imported.  
 
Images embedded in MS Word files will import automatically. However, if images are being 
imported with csv, rich-text, or txt files (see Importing Images below), browse to the folder that 
contains those images. 
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Step 2  
Specify whether the questions should be added to the currently open file or whether to create an 
entirely new file. If you select the second option you will need to enter the name of the file to be 
created and indicate whether the file should be an “Exam” or “Survey.” 
 
Each question being imported will have a “title”. If you don’t specify a title for each question in 
the text file itself (discussed below), Respondus will automatically use the first 20 characters of 
the question wording as the question title. Alternatively, titles can be based on a specific “stem” 
(or string of text) which will then be followed by consecutive numbering starting with 001. For 
example, if you select the “Use stem...” checkbox and enter the text “Chapter1-,” the title for the 
first question being imported will be Chapter1-001, the title for the second question will be 
Chapter1-002, and so on. (You do not have to enter a stem phrase--this feature is entirely 
optional.) 
 
Step 3  
Click the [Preview] button to preview the file being imported and to see if there are any warning 
messages. If warning messages are shown at the bottom of the screen, you need to determine 
whether to make changes to the text file or whether to continue with the import. Be aware that 
some warning messages don’t actually require you to make a change to the file being imported. 
For instance, Respondus will generate a warning message if two questions being imported have 
the same title (Respondus will place the number “2” at the end of the second title to make it 
distinct from the first). But if you don’t care about this issue, you can ignore the warning 
message. 
 
Step 4 
If you are satisfied with how the results look in Preview, click [Finish] to complete the import. 
The Respondus file has now been created or appended. Switch to the Edit menu to modify the 
file, or go to the Preview menu to view the file using a browser-like window.  
 
 
The Standard Format for Importing 
Respondus will import multiple choice, true-false, paragraph, short answer, matching, and 
multiple response questions. The plain text, rich text, or MS Word file must be organized in the 
“Standard Format” before it can be imported into Respondus. The Standard Format for multiple 
choice questions has required elements and optional elements, each of which is described below. 
This is followed by an explanation of the formatting required for true-false, paragraph, short 
answer, matching and multiple response questions. 
 
Required Elements (Multiple Choice) 
Each question must begin with a question number, followed by either a period “.” or a 
parentheses “)”.  
 
 Example:    3)   

Example:  3. 
 
 
The question wording must follow the question number. (Note: at least one space should be 
between the question number and the question wording.) 
 
 Example: 3) Who determined the exact speed of light? 

Example: 3. Who determined the exact speed of light? 
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Each answer choice (distractor) must begin with a letter (A-Z) followed by a period “.” or a 
parentheses “)”.  
 
 Example:  3) Who determined the exact speed of light? 
 
   a. Albert Einstein 
   b. Albert Michelson 
   c. Thomas Edison 
   d. Guglielmo Marconi 
 
 
Optional Elements (Multiple Choice) 
 
A Title can be imported with each question. If a title is not provided for a question, the first 20 
characters from the question wording will be used as the question title. Titles must be placed at 
the beginning of a question and begin with “Title:” followed by the actual text for the title. If the 
title exceeds 20 characters, the remaining characters will be dropped during the import.  
 
 Example: Title: Speed of Light 

  3) Who determined the exact speed of light? 
 
   a. Albert Einstein 
   b. Albert Michelson 
   c. Thomas Edison 
   d. Guglielmo Marconi 
 
For questions being imported to an Exam file, correct answers can be indicated in two ways. 
First, you may place an asterisk (*) directly in front of the answer choice (do not put a space 
between the asterisk and the answer choice). 
 
 Example:  Title: Speed of Light 

3) Who determined the exact speed of light? 
 
   a. Albert Einstein 
   *b) Albert Michelson 
   c) Thomas Edison 
   d. Guglielmo Marconi 
  
The second option is to place a list of correct answers at the end of the file. The list must begin 
with the word “Answers:” and the answers should start on the following line (no blank lines are 
allowed). Note that any text after the answer list will be ignored. 
 
 Example:  Answers: 

1. A 
   2. C 
   3. B 
 
If neither method is used to select a correct answer, Respondus will automatically select the letter 
“A” as the correct answer. Don’t worry, you will be warned if a question does not have an answer 
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selected for it prior to completing the import. (Note that survey files should not have “correct 
answers” selected. If you are importing questions into a survey file, any correct answer 
designations will be ignored.) 
 
With an Exam file, feedback for individual answer choices can be imported by placing the 
feedback immediately after the answer choice and by beginning the line with the @ symbol. 
There must be at least one space between the @ symbol and the feedback text.  
 
 Example:  Title: Speed of Light 

3) Who determined the exact speed of light? 
 
   a. Albert Einstein 
   @ No. Albert Michelson determined the exact speed of light.  
 
   *b) Albert Michelson 

@ Yes. Albert Michelson won the Nobel Prize for Physics for 
determining the exact speed of light. 

 
   c) Thomas Edison 
   @ No, Thomas Edison did not determine the exact speed of light. 
 
   d. Guglielmo Marconi 

@ No. Marconi did not discover the exact speed of light, but he did 
win the Nobel Prize for Physics for his work with radio waves.  

 
“General Feedback” can be imported in a similar way, but it must appear immediately after the 
question wording and before any of the answer choices. The line must also begin with the @ 
symbol, and there must be at least one space between the @ symbol and the feedback text. 
 
 Example:  Title: Speed of Light 

3) Who determined the exact speed of light? 
@ Albert Michelson was the first American to win the Nobel Prize in 
Physics (1907) for his measurements of the speed of light. His 
experiments laid the groundwork for Einstein’s Theory of Relativity. 

 
   a. Albert Einstein 
   @ No. Albert Michelson determined the exact speed of light.  
 
   *b) Albert Michelson 

@ Yes. Albert Michelson won the Nobel Prize for Physics for 
determining the exact speed of light. 

 
   etc. 
 
As shown in the previous example, both types of feedback can be used within a single question. 
(Note: if you are importing questions into a survey file, all feedback designations will be 
ignored.) 
 
 
Importing True and False Questions 
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The process of importing a “true and false” question is similar to that used for importing multiple 
choice questions (see above). Both of the following examples are valid ways to format a true and 
false question for importing purposes.  
 
 Example:  3) Albert Michelson determined the exact speed of light? 
 
   *a) True 
   b) False 
 
 
 Example:  3) Albert Michelson determined the exact speed of light? 
 
   *a. T 
   b. F 
 
It’s important to note that the “True” (or “T”) answer choice must be listed above the “False” (or 
“F”) answer choice in order for Respondus to recognize it as a true and false question type. (If 
“False” appears first in the list, the question will be imported as a “multiple choice” question.) 
 
To include a “title” or “feedback” with the true and false question, follow the same formatting 
rules described above for multiple choice questions. For instance, 
 
 Example:  Title: Light speed 

3) Albert Michelson determined the exact speed of light? 
@ Correct. Albert Michelson won the Nobel Prize for Physics for 
determining the exact speed of light. 

 
   *a. True 

@ Yes. Albert Michelson won the Nobel Prize for Physics for 
determining the exact speed of light. 

 
   b. False 

@ The correct answer is True. Albert Michelson determined the 
exact speed of light and won the 1907 Nobel Prize for Physics for his 
efforts.  

 
A second way to designate a correct answer for a true and false question is to place it in a list of 
correct answers at the end of the file. The list must begin with the word “Answers:” and the 
answers should start on the following line--no blank lines are allowed. The correct answer for a 
true and false question can be designated in three ways: (1) using the complete words “True” and 
“False,” (2) using the letters “T” and “F,” or (3) using the alphabetical letters “A” (for true) or 
“B” (for false). For example, the formatting of each of the following answers is acceptable for 
true and false questions in which all of the answers are “true”:  
 
 Example:  Answers: 

1. True 
   2. T 
   3. A 
 
 
Importing Paragraph Questions 



 12 

The logic for importing paragraph questions (also known as “essay” or “open-ended” questions) 
is similar to what is described above for multiple choice questions. The primary difference is that 
the first line of formatting must begin with “Type: P”. This is followed by the “Title” (which is 
optional), the question number, and the question wording.  
 

Example:  Type: P 
Title: Michelson-Morely experiment 

 
4) How is the Michelson-Morely experiment related to Albert 
Einstein’s theory of relativity? 

 
If you are importing a paragraph question into an Exam file, you can supply an answer two 
different ways. First, you may provide an answer immediately after the question wording, in 
which the answer begins with “a.” or “a)” (without the quotes).  
 
 Example: Type: P 

Title: Michelson-Morely experiment 
 

4) How is the Michelson-Morely experiment related to Albert 
Einstein’s theory of relativity? 

 
a) In 1887, Albert Michelson and Edward Morely carried out 
experiments to detect the change in speed of light due to ether wind 
when the Earth moved around the sun. The result was negative. 
They found the speed of light is always the same regardless of 
Earth's motion around the sun. Scientists were puzzled with this 
negative result, and they didn't know how to explain it. Albert 
Einstein came up with the answer in his famous second postulate in 
theory of relativity: that the speed of light (in vacuum) is always 
constant and absolute, regardless of its source's motion and 
observer's movement. 

 
The second way to supply an answer for a paragraph question is to place it in the list of correct 
answers at the end of the file. As described above with multiple choice questions, the list must 
begin with the heading “Answers:” and must be positioned at the end of the file. A paragraph 
answer should begin with the corresponding question number, followed by either a period “.” or a 
parentheses “)”. This is then followed by a space and then the answer itself. 
 
 Example:  Answers: 
   1. A 
   2. C 
   3. B 

4. In 1887, Albert Michelson and Edward Morely carried out 
experiments to detect the change in speed of light due to ether wind 
when the Earth moved around the sun. The result was negative. 
They found the speed of light is always the same regardless of 
Earth's motion around the sun. Scientists were puzzled with this 
negative result, and they didn't know how to explain it. Albert 
Einstein came up with the answer in his famous second postulate in 
theory of relativity: that the speed of light (in vacuum) is always 
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constant and absolute, regardless of its source's motion and 
observer's movement. 

   5. B 
 
Again, answers will be ignored if they are imported into survey files.  
 
 
Importing Short Answer Questions 
To import a Short Answer question, the first line of formatting must begin with “Type: S”. This is 
followed by the “Title” (which is optional), the question number, and the question wording.  
 
 Example:  Type: S 

Title: Who invented television? 
5. Who is known as the "father of television”? 

 
Respondus allows you to import only one correct answer per question, but it does permit you to 
enter multiple forms of that answer. 
 
 Example:  Type: S 

Title: Who invented television? 
5. Who is known as the "father of television"? 
 
a. Zworykin 
b. Vladimir Zworykin  
c. Vladimir Kosma Zworykin 
 

Answers can also be placed at the end of the file, using a format similar to multiple choice 
questions. The only difference is that you can enter multiple forms of an answer by repeating the 
question number. 
 
 Example:  Answers: 
   1. A 
   2. C 
   3. B 
   4. C 
   5. Zworykin 

5. Vladimir Zworykin  
5. Vladimir Kosma Zworykin 
6. B 
 
 

Importing Matching Questions 
The process of importing a “matching” question is similar to what is described above for 
importing multiple choice questions, but there are some key differences. The first line of 
formatting must begin with “Type: MT”. This is followed by the “title” (which is optional), the 
question number, and the question wording.  
 
Each answer (which consists of both portions of a correct match) must begin with a letter (a-z) 
followed by a period “.” or a parentheses “)”. The two parts of the match must be separated with 
an “=” symbol and there should not be any hard returns or blank lines within either parts of the 
answer.  
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 Example: Type: MT 

Title: Scientific discoveries 
 

4) Match the correct name to the discovery or theory. 
a. Michelson-Morely = Speed of light 
b. Einstein = Theory of Relativity  
c. Marconi = radio waves 

 
Spaces before or after the “=” symbol are optional, but it is important that an answer only uses the 
= symbol for the purpose of separating the two parts of the match. If you plan to list correct 
answers for other questions at the bottom of the document, simply skip the number for all 
questions that are of the matching variety. 
 
 
Importing Multiple Response Questions 
The logic for importing multiple response questions is similar to what is described above for 
importing multiple choice questions. (Multiple Response questions are, essentially, multiple 
choice questions in which more than one correct answer can -- and generally should -- be selected 
by the student). The primary difference is that the first line of the formatting must begin with 
“Type: MR”. This is followed by the “Title” (which is optional), the question number, and the 
question wording. Correct answers are designated with an asterisk. 
 
 Example:  Type: MR 

3) Which of the following individuals are credited with determining 
the exact speed of light? 

 
   a. Albert Einstein 
   *b. Albert Michelson 
   c. Thomas Edison 
   *d. Edward Williams Morley 
 
To include a “title” or “feedback” with multiple response questions, follow the same formatting 
rules described above for multiple choice questions. For instance, 
 
 Example:  Type: MR 

Title: Determining Speed of Light 
3) Which of the following individuals are credited with determining 
the exact speed of light?  
@ Albert Michelson and Edward Williams Morley collaborated on a 
series of experiments that eventually led to the exact determination 
of the speed of light.  
 

   a. Albert Einstein 
@ No. Albert Michelson and Edward Williams Morley collaborated 
on a series of experiments that eventually led to the exact 
determination of the speed of light. 

 
   *b) Albert Michelson 

@ Yes. Albert Michelson is one of the two persons credited with 
determining the exact speed of light.  
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   etc. 
 

(Note: this example illustrates how to include both “General Feedback” and answer-
specific feedback. In most cases, you would include only one type of feedback.) 
 

A second way to designate correct answers for multiple response questions is to place them in a 
list of correct answers at the end of the file. The list must begin with the word “Answers:” and 
must be positioned at the end of the file. If a question has been designated as a Multiple Response 
type using “Type: MR”, then correct answers can be shown in a list in one of three ways: (1) 
placing a blank space between the letters representing the correct answers, (2) placing a comma 
between the letters representing the correct answers, or (3) placing a comma and a blank space 
between the letters representing the correct answers. For example, the formatting of each of the 
following answers is acceptable for multiple response questions.   
 
 Example:  Answers: 

1. B D 
   2. B, D 
   3. B,D 
 
Important: Once the import file is organized to the specifications described above, it should be 
saved to MS Word (.doc), rich-text (.rtf) or a text (.txt) file. It is then ready to be imported by 
Respondus. 
 
  
Importing Images with Questions  
Images embedded in MS Word files will import automatically. However, it is possible to import 
images with rich-text or txt files using an alternate method. First, be sure that the images in gif, 
jpg, or jpeg format and are contained in a separate folder. Then place the following tag at each 
place where an image should appear:  [ img: “filename.jpg” ] .  The word “filename.jpg” should 
be replaced with the actual file name. 
 
 Example:  3) The interferometer, shown here [img: “interferometer.jpg”], was 
   used by which of the following scientists.   
   a. Albert Einstein 
   *b. Albert Michelson 
   c. Thomas Edison 
   d. Vladimir Zworykin 
 
To include alternative text for ADA-compliant screen readers, place the desired text in a second 
set of quotes immediately following the quotes that contain the file name: 
[ img: “interferometer.jpg” “Picture of an interferometer” ]. 
 
All images that are being imported must be placed in a single folder. During the import process, 
the location of the image folder must be specified in the first step. After the import is complete, 
the images will appear inline with the question text. 
 
 
Importing HTML with Questions 
It is possible to import blocks of HTML so that they are treated by Respondus as HTML rather 
than standard text. This is accomplished by placing the tag  [HTML]  immediately before the 
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block of HTML and another tag  [/HTML]  immediately after the block of HTML. So, for 
example, if you imported the following line of text: 
 
 [HTML] <a href="http://www.respondus.com">CLICK HERE</a> [/HTML] to  
 download Respondus. 
 
it would appear as follows when viewed in WebCT: 
 
 CLICK HERE to download Respondus. 
 
Of course, keep in mind that HTML will have variable results if you print the exam from 
Respondus rather than using it exclusively for online examinations.  
 
 
Importing Tab/Comma Delimited Files (CSV) 
Questions can be imported from tab/comma delimited files (.csv). This type of importing is best 
done by someone who has experience with databases or CSV-structured files.  
 
The CSV file can have a maximum of 34 columns. If all columns are used, they should follow 
this order: Type, Title/ID, Points, Question Wording, Correct Answer, Choice 1, Choice 2, 
Choice 3, Choice 4, Choice 5, Choice 6, Choice 7, Choice 8, Choice 9, Choice 10, General 
Feedback, Correct Feedback, Incorrect Feedback, Feedback 1, Feedback 2, Feedback 3, Feedback 
4, Feedback 5, Feedback 6, Feedback 7, Feedback 8, Feedback 9, Feedback 10, Topic, Difficulty 
Level, Meta 1, Meta 2, Meta 3, Meta 4. 
 
The first column, “Type” should use the two-letter abbreviation shown below: 
 

MC = Multiple Choice 
TF = True/False 
MR = Multiple Response/Answer 
FB = Fill in the Blank/Short Answer 
ES = Essay/Paragraph 

  
The following columns must always be present in the .csv file: Type, Title/ID, Points, and 
Question Wording, although the Points and Title/ID columns can be empty. If the Type is “ES” 
(essay), no further columns are required. If the Type is “MC” (multiple choice), “MR” (Multiple 
Response/Answer), “FB” (Fill in the Blank/Short Answer), or “TF” (True/False) there must also 
be a Correct Answer column (although for FB questions, this column is not used and can be 
blank). For MC, MR, and FB questions, “Choice 1” column must also be present. 
 
If the “Points” column is not empty, the value can range from 0-100 and will be rounded to two 
decimal places. If no value is provided, Respondus will assign the point value of 1.00.  
 
The formatting requirements for the “Correct Answer” column depend on the question type: 
 

MC - Supports numbers 1-10 or letters A-J (ignoring the case) 
 

TF - Supports numbers (1,2) and letters (A,B), where 1/A= true, 2/B= false. The words 
“true” and “false” are also supported. Capitalization is ignored for all answer types. 
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MR - Supports a list of numbers/letters within the range of 1-10 or A-J.  The 
numbers/letters must be separated by a comma or space; all must be contained within 
quotes. (e.g.  "a,c,h,j"  or “a c h j”). A trailing separator (e.g. "1,4,") is acceptable. 

 
ES - (This column isn’t used; use the Choice 1 column instead) 

 
FB - (This column isn’t used, use the Choice # columns instead) 

 
The following notes will be helpful in the development of your CSV file: 
 

- At the current time, the Topic, Difficulty, and Meta fields are being ignored and 
discarded. We are specifying these fields now so that they will be compatible with a 
future version of Respondus that will support them.   
 
- Blank lines between records are ignored. 
 
- Embedded line breaks within quotes are supported. 
 
- Literal column separators (within quotes) are supported. 
 
- Literal quotes (2 quote characters in sequence) are supported. 
 

The following notes are specific to the feedback fields: 
 

- all feedback columns are optional 
 

- general feedback is not supported in Blackboard, nor for essay/paragraph questions 
 

- correct answer feedback is not supported outside of Blackboard, nor for essay/paragraph 
questions 

  
- incorrect answer feedback is not supported outside of Blackboard, nor for 
essay/paragraph questions 

 
- choice-specific feedback is not supported in Blackboard prior to version 6, or for 
question types other than Multiple Choice; it is also not supported for fill-in-the-blank or 
essay/paragraph questions 

 
- choice-specific feedback for more than 2 answer choices is not supported for TF 
questions 

 
- choice-specific feedback is not supported for answer choices which do not exist 

 
To import the tab/comma delimited file with Respondus, select the “Import Questions” task from 
the Start menu in Respondus. Change the “Type of File” to “Tab/Comma Delimited (CSV)” and 
then browse to the file. A window will open and ask you to describe the type of data being 
imported (plain text or HTML, the number of header rows to skip, the type of delimiter, etc.). The 
Preview allows you to look at the data before the import is complete. If everything looks good, 
click OK to close the window. 
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If the CSV file contains HTML, it is possible to include image links such as <img 
src=""filename.jpg"">. (Notice that any single quote in the HTML must be changed to a pair of 
quotes in the HTML.) If images are referenced in the CSV file using HTML, then select the 
location of the image folder next. 
 
Finally, select from the remaining options that are available from the “Import Questions” task. 
Click Finish to complete the import.  
 
 
Exam Wizard 
The Exam Wizard helps familiarize new users with the basic functions of Respondus. In addition, 
the Exam Wizard is the best way to create an exam using questions contained in one or more 
Respondus files, such as a publisher test bank. The Exam Wizard allows questions to be 
randomly selected from the files that are chosen and to assign point values across an entire 
question type. (The discussion below primarily relates to Exam files. Fewer features are available 
if the file being created or appended is a Survey file.) 
 
To begin, select the Exam Wizard button from the Start menu. The first page of the wizard 
offers three choices. Select the top choice that states “Create a new exam and then copy questions 
to it from a question bank or Respondus file” and click [Next]. The next page of the wizard 
requires you to provide a name and description for the exam being created. Click [Next] once this 
information has been entered. The next page of the wizard prompts you to select the Respondus 
files from which the questions will be copied. Highlight a file and click the [Select] button. 
Repeat this process until all files that you want to use to select questions are chosen. Click [Next] 
to continue. 
 
The next page of the wizard prompts you to select one of the source files chosen in the previous 
step. You then have the choice of using Automatic Selection or Manual Selection. When 
Automatic Selection is chosen, the current number of questions for each question type is 
displayed in the “Available to Select” column. In the next column, enter the number of questions 
you want selected for each question type. Then enter the point values to be assigned to each 
question type (this step is optional--if you leave the “points per question” field blank, the point 
values from the original file will be used). When all entries are finished, click either the [Add to 
End of List] button or the [Insert Into List] button. Repeat this process for each source file.  
 
The Manual Selection option allows the questions for each file to be viewed before making a 
selection. In fact, you can preview individual questions by clicking the title of a question, or by 
searching the entire list of questions by clicking the [Keyword Search] button at the top right. To 
select questions from this list, click in the column furthest to the left--a checkmark will appear 
next to the question. When you are finished with your selections, click either the [Add to End of 
List] button or the [Insert Into List] button. Repeat this process for each source file.  
 
The Automatic Selection and Manual Selection options may be combined. You may also reselect 
a file from the pull-down list and choose additional questions from it. However, Respondus will 
prevent you from selecting a question more than once.  
 
Once questions have been added to the list at the bottom of the screen, you may edit the point 
values manually. To delete a question from the bottom list, or to move it to a different location in 
the list, click the blue title and select the desired option. Finally, notice that a tally of the total 
number of questions and point values appears at the top right corner of the lower grid. 
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The next and final page of the wizard is self-explanatory. It provides a variety of options as to 
what can occur next. For example, to edit questions in the file, you would select the option to go 
to the Edit menu. To print the exam, you would select the Printing option, and so on.  
 
Click [Finish] to complete the wizard. (Note: Respondus does not permit you to copy questions 
from a Survey file to an Exam file. Also, some features in this task are disabled when the file 
being created is a Survey.) 
 
 
Archive Wizard 
The Archive Wizard in Respondus allows you to archive an exam or survey, including all media 
components and equations that may be associated with it. An entire “tree” of folders can also be 
archived. The Archive Wizard and related tasks are useful for doing routine backups, to create a 
ready-to-use exam/survey file that can be e-mailed to a colleague, or for organizing the “Projects” 
folder so that only current files are displayed. Archive files require considerably less hard drive 
space because the contents are stored in a compressed format. 
 
Creating an Archive File 
To create a Respondus archive file, go to the Start menu and select the “Archive Wizard” option. 
A directory of the Respondus Projects folder is now displayed. Highlight the file or folder that 
you want to archive and click [Next]. The next screen specifies the name of the file or folder that 
will be archived, plus the location to where the archive file will be saved. (It is possible to choose 
a different location, but this is not recommended since it will later require additional steps to 
restore the archived file). The final screen of the wizard indicates that the archiving is complete 
and provides the location of the archived file. Additional information is provided in a “Notes” 
section.  
 
There is a faster way create Respondus archive files, albeit without the guidance of a wizard. 
From the Start menu, select the Open task. Two large buttons appear on the left side of the 
window: Projects and Archive. The Projects folder is where all active Respondus files and folders 
are stored. When files are archived, they are placed in the Archive folder. To archive a file, click 
once on a file (or folder) in the Projects area and then click the small button on the toolbar at the 
right called Create Archive File (the icon looks like a filing cabinet). A name for the archive file 
is suggested by Respondus; you may accept this name or provide a different one. When the [OK] 
button is clicked, all files associated with the exam or survey (including media objects) are 
compressed into one file and it is placed in the Archive. If you are archiving a folder that contains 
multiple Respondus files, all the files contained within the folder will be included in the archive 
file. It is important to note that the original Respondus files are not deleted from the Projects area 
when they are archived. If you want to delete the original Respondus files, highlight them again 
in the Projects area and select the Delete File button (it looks like a “recycle waste basket”) 
located on the toolbar at the right.  
 
If you accepted the standard settings when Respondus was installed, the archived files will be 
located on your hard drive at c:\Respondus Projects\Archives. The files will have the extension 
“.rsa” (specially licensed versions of Respondus will output files with the .rpa extension). The .rsa 
files can then be copied to another location for backup purposes or sent to a fellow user of the full 
version of Respondus.  
 
Restoring an Archive File 
There are two ways to restore a Respondus archive file (.rsa, .rpa) to the Projects area. The first 
approach works only if the archive file was saved to the default Archives folder (which can 
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generally be found at c:\Respondus Projects\Archives). From the Start menu in Respondus, click 
the Open button. Select the large Archive button on the left side of the screen, highlight the file 
you want to restore, and click the [Open] button at the bottom right. The archived file or folder 
will then be restored and copied to the Projects folder. To then open the restored file in 
Respondus, click the Projects button and select the restored file.  
 
If the archive file (.rsa, .rpa) is not located in the Archive folder, make sure the Projects button is 
selected and click [Browse…].  Navigate to the location of the archive file, highlight it with your 
mouse, and then click [Open]. The archive file will be restored and copied to the Projects folder. 
You will then need to open the file in the Projects folder in order to view or edit it.  
 
Please note that an archive file is not deleted from its original location when it is restored to the 
Projects folder. 
 
 
Changing the CMS “Personality” and Converting Files 
Each course management system (e.g., Blackboard, eCollege, WebCT) is different in terms of the 
question types it offers, the approach it uses to create and manage exams, and even the 
terminology that is used. This is why Respondus allows the user to select an environment or 
“personality” that matches a particular course management system. For example, one user might 
use a “WebCT” personality, another might select the “eCollege” personality, yet another might 
choose a “Blackboard” personality, and so forth. Each user will feel right at home because the 
features and terminology will closely parallel their course management system.  
 
Changing the Personality 
To switch to a different personality in Respondus, go to the Start menu and select the desired 
personality from the list that appears at the top of the screen. If the currently open file was created 
(or imported) using a different Respondus personality, a message will warn you of this and 
indicate that the file will be converted to the new personality if you continue. Click [OK] to 
continue and you will see one or more warnings of what will be modified when the file is 
converted. In some situations, you will be given a choice of how certain items will be converted. 
For instance, if you are converting a file from the Blackboard 5.x personality to the WebCT 
personality, you may encounter a message asking how “feedback” for answers should be handled.  
 
After the file is converted, a screen will detail every modification or change that occurred to the 
file during the conversion process. You must then determine whether to “replace the current file” 
with the newly converted file, or to “save as a new file”.   
 
If you plan to convert a large number of files and you want to use the same conversion settings, it 
is recommended that you go to the File>Preferences>Conversion screen and set your conversion 
settings accordingly. In this way you won’t have to specify your conversion preferences each 
time you convert a file.  
 
If you are unsure which CMS personality was used to create a file, go to the Start menu, select 
Open, highlight the Respondus file, and select the “General Information” button from the small 
toolbar at the right (represented by a file folder with an overlaying question mark.)  The CMS 
personality that was used to create the file will be displayed in the information window below.  
 
Quarantined Questions (after a file is converted) 
Some course management systems have question types that simply cannot be used by other 
course management systems. During the conversion process, Respondus will provide the option 
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to drop such questions or have them “quarantined” in the newly converted file. In most situations 
it is best to drop the question entirely. But if, at a later time, you plan to use the converted file 
with the originating course management system, the quarantine option will preserve the questions 
for this purpose.  
 
The title of a quarantined question will appear in red in Respondus (instead of the normal color of 
blue). Also, if a quarantined question is included in the file when it is published to a course 
management system, the question will be filtered out during the publishing step. 
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Editing a File 
Overview 
Common Features Across all Question Types 
 - Multiple Choice   

- True and False 
 - Paragraph  

- Matching 
 - Short Answer 
 - Multiple Response 
 - Fill in the Blank 
 - Jumbled Sentence 
 - Calculated 
 - A Note About “Combination” Questions 
Adding Bold, Italics, Underline, and Super/Subscript 
Adding Images, Media and Attachments to Questions 
Web Links 
HTML Editor 
Equation Editor 
Power Editor 
 - Tables 
 - Fonts, Formatting, and Lists 
Spell Check 
Keyword Searches 
Modifying, Rearranging, and Deleting Questions 
Using a Question as the Basis for a New Question 
Copying Questions from Another Respondus File 
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Overview of Edit Menu 
The Edit menu allows questions to be added to the currently open file.  
 
There are nine question types that can be created in Respondus: Multiple Choice, True and False, 
Paragraph, Matching, Short Answer, Multiple Response, Fill in the Blank, Jumbled Sentence, and 
Calculated. Feedback and point values can be added to questions, as can images, multimedia, 
tables, HTML and various types of enhanced formatting. 
 
The appearance of the Edit menu is dependent on whether you open an exam or a survey file. 
This is because fewer options are available for survey files (correct answers, point values, and 
feedback are not used with surveys). The discussion below primarily describes the use of the Edit 
menu as it relates to exam files.   
 
To create a new question, select the desired question type on the left side of the screen. The 
template on the right side of the screen will change accordingly.  
 
 
Common Features Among All Question Types 
All question types require you to enter a “Title.” The title can be up to 64 characters. If you do 
not enter a title, Respondus will use the first 20 characters from the “Question Wording” for it. 
 
All question types have a “Question Wording” section. This is where the main body of the 
question is entered.  
 
Some question types allow the entry of “feedback.” If feedback is enabled for a particular quiz 
(determined later using the “Settings” menu), students will see the feedback for the answers they 
selected when they view their graded quiz. To enter feedback for a question (regardless of 
whether you later decide to have it displayed), select the Enable Feedback option on the left side 
of the screen. The form will then display fields where feedback can be entered. “General 
Feedback” can also be entered by clicking the [General Feedback] button and entering the 
desired information. (Note: If you deselect the Enable Feedback option, all feedback remains 
stored with the question. It simply does not display the feedback on the Edit screen until the 
option is reselected.) 
 
Four buttons appear at the bottom of all edit forms. The [Add to End of List] button adds the 
current question to the end of the “Question List” (located at the bottom of the screen). The 
[Insert Into List] button lets you insert the current question into the Question List at a specified 
location. The [Clear Form] button will erase all data that currently shows in the form. Finally, 
the [Preview] button opens a browser-like window that lets you view how the question will 
display in the final quiz—feedback and scoring information is also shown in this window. The 
Preview button can be selected at any stage in the editing process.  
 
The “Question List” displays the title, question type, and question wording for each question in 
the file. The total number of questions and point values is shown at the top of the list. By clicking 
on the “title” of a question, a window containing the “properties” for the question is displayed. It 
is here where you can modify, delete, or move questions, as well as use a question as the basis for 
an entirely new item. These features are discussed below under “Modifying, Rearranging, and 
Deleting Questions.”   
 
 



 24 

Multiple Choice 
Multiple Choice questions in Respondus allow up to 26 answer choices (also known as 
distractors), but only one correct answer can (and must) be selected. You must also provide a 
point value for each question (the default setting is “1”).  
 

Tip: The easiest way to navigate between the “Answer” fields in Multiple Choice 
questions is to use the PageUp and PageDown keys.   

 
Answer choices for multiple choice questions can be randomized during a WebCT exam by 
selecting the “randomize” checkbox located just above the answers list.  
 
With survey files, correct answers and point values cannot be included with multiple choice 
questions. You can, however, include a “Favorite Answer List” that allows the storing of 
frequently used answer sets or scales (e.g., Strongly Agree, Agree, Disagree, Strongly Disagree). 
To create a Favorite Answer List, enter the answers in the Edit form and click the [Favorite 
Answer List] button. Then select the option to “Create a new answer list…” and give it a name 
that allows you to quickly identify it at a later time. To use a previously defined answer list with a 
survey file, click the [Favorite Answer List] button, select the option “Use the Answer List 
selected below,” select the answer list to be used, and click [OK]. 
 
With Survey files, the Multiple Choice task also includes a “Multiple Response” checkbox that 
enables the respondent to select more than one answer.  
 
True and False 
True and False questions are self-explanatory: enter the statement in the question wording field 
and then select either “True” or “False” as the correct answer. With Survey files, the True and 
False question type is replaced with a “Yes and No” question type. However, “Yes and No” 
questions are placed in the general “Multiple Choice” category when published to WebCT. 
 
Paragraph 
Paragraph question types (also known as “essay” questions) allow students to enter complete 
sentences or paragraphs for their answer. If the “Enable Feedback” option is turned on, a correct 
answer can be provided. However, these questions must be graded manually in WebCT. 
 
The paragraph question type includes a “pre-fill Answer box” feature that allows an instructor to 
enter text that will appear in the answer box when the question is displayed during a quiz. This 
feature only supports plain text.  
 
Matching 
Matching questions require students to match items from two columns. There are two ways to 
create matching questions in Respondus. First, the designer may specify matching pairs for both 
the left and right columns—specifically, the correct match for the left column must be placed in 
the field immediately to the right. If this procedure is followed, it is not necessary to indicate the 
correct answer in the small column located at the far left. (Note it is possible to place extra 
answers in the right column. In this situation, the extra answers act as decoys and do not match 
any of the answers in the left column.) 
 
The second approach for creating matching questions allows items in the right column to be 
placed in any order, but requires the correct answer for the match to be indicated in the small 
column located at the far left. This approach is especially suited for questions in which a long list 
of items (e.g., country names) is being matched to a relatively short list of items (e.g., type of 
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government). For example, the left list might contain 25 countries (Afghanistan, Albania, Algeria, 
Angola, Argentina, etc.) while the list on the right might display four types of government (Multi-
Party Democracy, One-Party Regime, Military/Monarchical/Theocratic Regime, Disordered 
State). Instead of entering the type of government for each country, you can simply enter the 
letter of the correct answer in front of the country name. See the table below. 
 
   Column1  Match Column 
                D Afghanistan  A. Multi-Party Democracy 
                A Albania   B. One-Party Regime 
                C Algeria   C. Military/Monarchical/Theocratic Regime 
                D Angola   D. Disordered State/Civil War 
                A Argentina 
                A Austria 
                A Bahamas 
                C Bahrain 
                A Bangladesh 
                B China 
                B Cuba 
 
In a matching question, the left column will be displayed to the student in the order information 
was entered. The right column appears as a list of drop-down menus that students can use to 
select the appropriate match. Answers in the drop-down menus are randomized. 
 

Tip: The easiest way to navigate through the answer choices is to use the PageUp and 
PageDown keys.  Press the PageDown key twice to move through the “correct match” 
field. 

 
All answer choices are equally weighted with matching questions. So if a question has 10 
matches, each match is worth 10%. There are three choices for grading:  
 

• Proportional to the Number Correct - All answers are equally weighted, without any 
penalty for incorrect answers. So if a student matches 8 of 10 items correctly, the 
score would be 80% on that question.  

 
• All Points or None – The student must answer all items correctly in order to receive 

100% credit. If any items are missed, no credit is given for the question. 
 

• Right Less Wrong – This option sums the number of correct answers and then 
subtracts the number of wrong answers. Hence, if the student answers 8 items 
correctly and two items incorrectly, the score is 6 (8 correct - 2 incorrect). 

 
Short Answer 
Short Answer questions (also known as fill-in-the-blank questions) require students to enter a 
word, short phrase, or string of characters. Since the computer automatically grades the answer, 
students must give an answer that exactly matches one of the answers provided by the teacher. 
The standard edit window in Respondus only allows one fill-in-the-blank answer per question. 
However, it is possible to create questions that have multiple answers (e.g., “Name the first 5 
elements of the periodic table”) by clicking the “Advanced” button that appears above the answer 
grid (this feature is explained later in this section).  
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Using the standard editing grid, Respondus allows the designer to provide multiple variants of the 
correct answer. For instance, if the answer to a question is “New York Yankees,” the designer 
might enter each of the following as an acceptable answer:  
 
 Yankees 
 New York 
 New York Yankees 
 NY Yankees 
 
Two types of credit can be given for short answer questions. The “Equals” (exact match) option 
requires the student to type an exact word or phrase, but ignores capitalization. The “Contains” 
option also requires the user to type an exact word or phrase, but it ignores extra words or 
characters that appear before or after the answer provided by the instructor (capitalization is 
ignored too). Note that the “regular expression” option is available for users who want to 
implement Perl scripting language for determining credit for short answer questions. The use of 
this feature is beyond the scope of this user guide. 
 
Short Answer - Advanced 
The “Advanced” button that appears above the answer grid in the short answer editor allows the 
creation of more sophisticated short answer questions. First, more than one correct answer can be 
required of the student (e.g., “Enter the names of the first two men who walked on the moon?”). 
Second, the order of the correct answers can be specified (e.g., “In the first blank enter the name 
of the first man to walk the moon. In the second blank enter the name of the second man to walk 
on the moon.”). Third, it is possible to assign different point values for each answer choice (e.g., 
Neil Armstrong = 40% of the point value, Buzz Aldrin = 60% of the point value).  
 
To begin, click the “Advanced” button to change the standard answer grid to the advanced 
answer grid. If the question requires students to fill in two or more answer blanks, but the order in 
which the answers are entered doesn’t matter, then simply list each correct answer in the wide 
grid section at the right.  

 
However, if the question requires students to fill in two or more answers, and the order in which 
the answers are entered does matter, then the middle column in the grid should be used to specify 
the position of each correct answer. For example, if the first answer must be entered as 
“Armstrong” and the second answer must be entered as “Aldrin,” then the grid should look like 
this: 

 
If you want to allow multiple variants for each correct answer, that too can be accomplished if 
each answer choice has a specified order. For example, consider the following question: “In the 
first blank below, enter the name of either astronaut who walked on the moon as part of the 
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Apollo 11 mission. In the second blank, provide the name of the astronaut who orbited around the 
moon in the mother ship, but never walked on the moon.” 
 
Finally, it is possible to distribute the point value for each correct answer according to the 
percentages specified in the leftmost column. For example, if the total point value for the 
following question is worth 10 points, the instructor might assign one answer a higher percentage 
of these points: “Who were the first two astronauts to walk on the moon?” 
 

 
In this example, students who provide the correct answer of “Armstrong,” but do not provide the 
correct answer of “Aldrin,” will only receive 40% of the point value (in this case 4 of 10 points).  
 
Multiple Response 
Respondus provides a separate question type for multiple choice questions that have more than 
one correct answer. The Multiple Response question type is very similar to Multiple Choice 
questions, except that students can (and should) select more than one correct answer. (When 
multiple response questions are transferred to WebCT, they are placed in WebCT’s broader 
“Multiple Choice” category.) 
 

Tip: The easiest way to navigate through the answer choices is to use the PageUp and 
PageDown keys.  Press the PageDown key twice to move through the “correct answer” 
field. 

 
Answer choices for multiple response questions can be randomized during a WebCT exam by 
selecting the “randomize answers” checkbox located just above the answers list.  
 
In the column that precedes the answer choices, the letter “X” should be entered for all correct 
answers. WebCT will assign equal value to all answers indicated as correct. Thus, if two of four 
answers are marked as correct , each correct answer will be worth 50% of the point value. If the 
designer selects three of four answers as being correct, each correct answer will be worth 33.3%.  
 
It is also necessary to select the type of “Credit Given” for correct and incorrect answers. 
Respondus offers two choices: “Right Less Wrong” and “All Points or None”. The “All Points or 
None” setting is straightforward: if any portion of the answer is wrong, no points will be awarded 
for the question. If the “Right Less Wrong” option is selected, incorrect choices are subtracted 
from correct choices. For example, if a student accurately selects the two answers out of four that 
are correct, but additionally selects a third answer that is wrong, she would receive 100% for 
answering the two questions correctly, minus 50% for the incorrect answer (for a total score of 
50%). It should be noted that the default setting in Respondus prevents the final point value for a 
question from being negative (thereby preventing a student from losing points for answering the 
question incorrectly). This setting can be overwritten once questions are published to WebCT. 
 
Entering Percentage Values for Each Answer  
With Multiple Response questions, it is also possible to assign exact values for each correct and 
incorrect answer.  Instead of placing an “X” in front of the correct answers, values totaling 100% 
for the correct answers can be entered. Conversely, negative values totaling –100% can be 
entered for the incorrect answers. The logic for this can be confusing at first, but the best 
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approach is to simply remember that the correct answers should total 100% and the wrong 
answers should total –100%. For example, if answers A and C are correct and answers B and D 
are incorrect, you might assign values as follows: 
 
  50% A) Answer A (correct) 
  -50% B) Answer B (wrong) 
  50% C) Answer C (correct) 
  -50% D) Answer D (wrong) 
 
In fact, this matches what Respondus does automatically when you enter “X” for the correct 
answers. However, it is also possible to place unequal weights on right and wrong answers, 
although one should do so carefully. 
 
  60% A) Answer A (correct) 
  -70% B) Answer B (wrong) 
  40% C) Answer C (correct) 
  -30% D) Answer D (wrong) 
 
For this type of grading, be sure to select the “Right Less Wrong” setting for the “Credit Given” 
option. Also remember that the default setting in Respondus prevents the overall point value for a 
question from being negative (thereby preventing students from losing points for answering the 
question incorrectly). This setting can be overwritten once questions are published to WebCT. 
 
Again, the best approach is to make sure that correct answers total 100% and wrong answers total 
–100%. Incidentally, if you only assign positive values for the correct answers and leave wrong 
answers as zero, students will be able to select all answers for a question and obtain 100% credit. 
Use this option carefully!  
 
 
Fill in the Blank 
The Fill in the Blank question type presents students with questions that contain multiple blank 
spaces that must be filled in. For example: 
 
 People who live in _______ houses shouldn’t throw ________ . 
 
For each blank that you want to appear in the question, you most enclose the correct answer in 
square brackets. For the above example, the question wording would appear as follows: 
 
 People who live in [glass] houses shouldn’t throw [stones]. 
 
The words in brackets will automatically be converted to answer blanks when presented to the 
student. This can also be previewed by clicking the “Preview” button. 
 
Since the computer automatically grades the answers, students must provide answers that exactly 
match the answers provided by the teacher. Respondus only allows you to specify one answer per 
blank. (If you need to specify more than one correct answer for a specific answer blank, you must 
edit the question in WebCT after it has been uploaded by Respondus.)  
 
 
Three types of credit can be specified for given for Fill in the Blank questions. The “Equals” 
(exact match) option requires the student to type an exact word or phrase, but ignores 
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capitalization. The “Contains” option also requires the user to type an exact word or phrase, but it 
ignores extra words or characters that appear before or after the answer provided by the instructor 
(capitalization is ignored). The third type of credit can be determined by using a “regular 
expression.” This uses the Perl scripting language, which beyond the scope of this user guide. 
 
 
Jumbled Sentence 
The Jumbled Sentence question type presents students with a sentence in which missing words 
must be selected from a drop-down list.  
 
To create a Jumbled Sentence question in Respondus, brackets are placed around each word or 
phrase that is to be included in the drop-down list. 
 
 [the rain] [in Spain] falls [mainly] [on the plains] 
 
In this example, the text that appears in square brackets is replaced by drop-down lists which 
display words or phrases: the rain, in Spain, mainly, on the plains. The student is required to put 
the words and phrases in the correct order.  
 
Note that only plain text can be used within the square brackets -- that is, you can’t place images, 
equations, web links, HTML blocks, or any type of formatting (eg., bold, italics) within the 
brackets. 
 
 
Calculated 
Calculated questions require students to apply a mathematical formula to answer the question. 
Calculated questions are designed using variables. Random values, based on a specified range, 
are automatically generated for each variable in the question. Thus, calculated questions can be 
unique for each student, as illustrate in this example where values are inserted for [x] and [y]. 
 

Example: If a car is traveling [x] miles per hour for [y] hours, how far does it travel (in 
miles)?  
 

The Respondus editor for Calculated questions contains the following sections that need to be 
completed: 
 

• Question Wording 
• Formula 
• Variable Properties 
• Answer Properties 
• Value/Answer Sets 

 
Calculated – Question Wording 
In the Question Wording section, enter the text of the question just as you would for any other 
question type. However, instead of using specific numerical values to define the details of the 
question, instead use variables by specifying a name enclosed in square brackets for each one. For 
example: “How long does it take to travel [x] miles at a speed of [y] mph?” 
 
Variable names can only contain letters and digits (the characters 0-9, a-z, and A-Z), and the “_” 
(underscore) character. In addition, the first character of a variable name cannot be a number. 
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You can use as many different variables as you need to define the question, and you can use the 
same variable name multiple times if necessary. 
 
Calculated - Formula 
In the Formula section, enter the mathematical formula associated with the question. This is the 
same formula that the student will be expected to use, and the same one that will be used to 
automatically calculate the correct answer for grading purposes. The same variables specified in 
the question wording will be used to indicate where each value should go in the formula. 
 
The formula can be typed into the edit field directly, or entered by selecting options from the pull-
down lists provided for Variables, Functions, Operators, and Constants. Selected options will 
appear in the edit field at the current cursor location, and will overwrite the current selection (if 
any). 
 
The “Variables” list provides an easy way to select a common variable name. 
 
The “Functions” list provides the following supported mathematical functions: 
 

abs(x)  Absolute value of x. abs(-3) = 3. 
acos(x)  Arc-cosine of x in radians 
acosh(x) Hyperbolic arc-cosine of x in radians 
angle(x,y) Arc-tangent of x/y in radians. Uses signs to determine result quadrant. 
asin(x)  Arc-sine of x in radians 
asinh(x) Hyperbolic arc-sine of x in radians 
atan(x)  Arc-tangent of x in radians 
atan2(x,y) Same as angle(x,y) 
atanh(x) Hyperbolic arc-tangent of x in radians 
ceil(x)  Round x up to the nearest integer. ceil(2.1) = 3. ceil(-2.1) = -2. 
cos(x)  Cosine of x in radians 
cosh(x)  Hyperbolic cosine of x in radians 
exp(x)  Base e (Euler’s constant) raised to the power of x 
fact(x)  Factorial of x. fact(3) = 6. 
floor(x)  Round x down to nearest integer. floor(2.8) = 2. floor(-2.8) = -3. 
int(x)  Return integer portion of x. int(4.32) = 4. int(-4.32) = -4. 
ln(x)  Base e natural logarithm of x 
log(x)  Same as ln(x) 
log10(x) Base 10 logarithm of x 
max(x,y,…) Return the maximum of all supplied arguments. max(1,2,3) = 3. 
min(x,y,…) Return the minimum of all supplied arguments. min(1,2,3) = 1. 
mod(x,y) Modulus or remainder of x/y. mod(5,2) = 1. 
rand()  Return a random number between 0 and 1 
round(d,x) Round x to d decimal places. Halfway cases round away from 0. 
sin(x)  Sine of x in radians 
sinh(x)  Hyperbolic sine of x in radians 
sqrt(x)  Square root. sqrt(9) = 3. 
sum(x,y,...) Return the sum of all supplied arguments. sum(1,2,3) = 6. 
tan(x)  Tangent of x in radians 
tanh(x)  Hyperbolic tangent of x in radians 

 
Note that the values for trigonometric functions are expressed in radians, not degrees. For 
conversion purposes, Pi radians = 180 degrees. Also, for all formulas that have two correct 
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answers (for example, the square root of 9 is +3 and -3), only the positive number will be treated 
as correct. 
 
After selecting a function from the list, the formula must be edited to replace the argument list 
with numbers or variables. For example, “round(d,x)” might be edited to specify a fixed number 
of decimal places and a variable to round, as in “round(3,[y])”, which would round the variable 
[y] to 3 decimal places. 
 
Functions can also be nested within a formula, as in “sqrt(abs([x]))”. In this case, the absolute 
value of [x] is evaluated first, followed by the square root of the result. Functions can be nested as 
deeply as necessary to properly calculate the answer. 
 
When entering numerical values, scientific notation is expressed in the format xEy, where x is the 
coefficient and y is the exponent. To convert numbers from scientific notation to standard 
notation, use x times 10 to the power of y. For example: 
 

• 3.2E4 equals 32000 
• -2E0 equals -2 
• 3.14E-2 equals 0.0314 

 
The “Operators” list provides the following standard mathematical operators: 
 

- Subtraction 
! Logical NOT. !(0) = 1, !(1) = 0, !(-3.14) = 0 
% Modulus or remainder. For example, 5%2 = 1. 
&& Logical AND. 0&&0 = 0, 0&&1 = 0, 1&&1 = 1, 3&&-2.5 = 1 
() Parentheses used to group elements for precedence 
* Multiplication 
** Power or exponent. For example, 2**3 = 8. 
/ Division 
|| Logical OR. 0||0 = 0, 0||1 = 1, 1||1 = 1, 3||-2.5 = 1 
+ Addition 

 
The “Constants” list provides the following commonly-used numerical constants: 
 

_e Base e or Euler’s constant (2.71828…) 
_pi Pi – the circle ratio (3.14159…) 

 
Some example questions and associated formulas might be: 
 

Question: How long does it take to travel [x] miles at a speed of [y] mph? 
Formula: [x]/[y] 
 
Question: What is the positive square root of [x]? 
Formula: sqrt([x]) 
 
Question: Compute sin(x) where x = [x] degrees. 
Formula: sin([x]/180*_pi) 

  
Calculated - Variable Properties 
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Clicking the “Variable Properties” button in the Formula section displays the Variable Properties 
dialog. Here, each variable in the question wording and formula is listed by name, along with 
Minimum, Maximum, and Precision values for that variable. 
 
The Minimum and Maximum define the range of values each variable can be assigned, and the 
Precision specifies the number of decimal places each value should be allowed before the value is 
rounded off. 
 
You can click each cell in the grid to edit the specific minimum, maximum, or precision value 
you want to change (the variable names cannot be edited). In general, for a given variable the 
minimum must be less than or equal to the maximum, and the precision must be greater than or 
equal to 0 and less than or equal to 5. 
 
Calculated - Answer Properties 
Clicking the “Answer Properties” button in the Formula section displays the Answer Properties 
dialog. Here you can specify values for answer precision and acceptable tolerance, as well as a 
unit name and associated score percentage. 
 
Answer precision can be specified in Decimal Places or Significant Figures. If the precision is 
specified in decimal places, the value must be greater than or equal to 0 and less than or equal to 
5, just as with the precision values specified in the Variable Properties dialog. If the precision is 
specified in significant figures, the minimum value is 1. 
 
Answer tolerance is the amount that the student’s answer can deviate from the calculated answer 
and still be considered correct. It can be specified as a fixed number of units or as a percentage of 
the answer value. 
 
If you choose to require a unit name, you must enter a unit name and a percentage of the total 
question score that the correct name will be worth. Comparisons with the name entered by the 
student will be case-insensitive and space-insensitive. The score percentage must be greater than 
or equal to 0 and less than or equal to 100. 
 
Calculated - Value/Answer Sets 
Clicking the “Value/Answer Sets” button below the Formula section displays the Value/Answer 
Sets dialog. Here you can generate sets of variable values and calculate the associated answers 
using the formula previously entered. When the Calculated question is presented to the student, 
one of these value sets will be randomly chosen to populate the variables in the question wording 
and the formula, and the associated answer will be used to grade the student’s response. 
 
The grid displays a list of numbered value/answer sets. The number of sets available can be 
selected from the “Number of Sets” pull-down list. For each set, the generated values for each 
variable are shown, and the individual cells can be clicked to edit those values. Note that any 
manually-entered values must be within the range specified by the variable minimum and 
maximum in the Variable Properties dialog. The answers cannot be edited; instead, the “Update 
Answers” button can be clicked to recalculate the answers for all value sets. 
 
 
A Note About “Combination” Questions 
Respondus does not allow you to create or edit “combination” questions. These questions types 
must be created directly in WebCT using a browser. However, if a combination question is 
created in WebCT, Respondus will download it along with the other question types (see the 
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Retrieval and Reports menu). Once downloaded, combination questions can be moved, copied, 
deleted, or resubmitted to the WebCT server.  
 
 
Adding Bold, Italics, Underline, and Super/Subscript 
Respondus makes it easy to add enhanced formatting to question wordings, answers, and 
feedback. The bold, italic, and underline tasks work just like a standard word processor. Simply 
highlight the text you want to modify and click the appropriate [B], [I], or [U] button on the tool 
bar. The text will immediately change to the selected formatting. The superscript [X2] and 
subscript [X2] tools function in the same manner. To remove any of the above-mentioned 
formatting, simply highlight the text again and reselect the corresponding button from the toolbar. 
(Please note that although the underlying “HTML tags” are not displayed in Respondus, these 
tags will be transferred to -- and displayed by -- WebCT when the file is uploaded.) 
 
 
Adding Images, Media and Attachments to Questions 
One of the more powerful features in Respondus is the ease in which media (e.g., images, audio 
clips, video clips) and attachments (e.g., spreadsheets) can be added to exams. Media content can 
be added to question wordings, answer choices, and feedback without writing or viewing HTML. 
In addition, the media objects can be previewed offline, and everything is automatically uploaded 
to WebCT during the Publish process. 
 
From the Edit menu, position the cursor at the place in the question where you want the media 
item added. Then click the “Insert Picture or File” icon on the toolbar, which is represented by a 
camera icon. A pop-up window will let you navigate to the media file and select it. The default 
“file type” setting will display only bitmap, jpeg, gif, png, and pcx files. To display .wav, .avi, 
and other audio/video files, select the “Audio-Video” option from the pull-down menu labeled 
“Files of Type.” The third option on the list (All Files) allows you to select other types of media 
files, as well as attachments (such as a spreadsheet or word processor document). 
 
Most graphical images on the web are stored in jpeg, gif or png format. Consequently, if you 
select a graphic that is in another format (such as bitmap or pcx), Respondus will allow you to 
convert it to a jpeg file with the click of a button. Similarly, if the graphic you select is over 600 x 
450 pixels in size, Respondus will allow you to convert it to more suitable dimensions. The 
program automatically detects if a graphic you select is larger than 600 x 450 pixels or if it is not 
stored in jpeg, gif or png format. In such cases, the following screen will appear:  
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In most situations, you can simply click [OK] to accept the suggested settings. If you prefer to 
customize the settings -- or to retain the original format and size -- that can be done too. An 
additional option lets you add a border to the graphic. Select the settings you prefer and click 
[OK]. 
 
An additional window that prompts you to add text description for the image (an “Alt” field) will 
appear. Screen readers use the text that is entered here; this text is also used when the mouse 
pointer is held over the image. If you simply click [OK] to close the window, the actual name of 
the image file will be used (such as “cat.jpg”). If you want to type in a more helpful textual 
description (such as “cat sleeping on pillow in front of a sunny window”), the complete 
description will be used by the screen reader. Keep in mind, though, that the text description of 
the image may tip students to the correct answer for a question. In this case, you may want to edit 
the text description so that it doesn’t give away the correct answer. Note that you can prevent the 
window that prompts you to enter the Alt text description from appearing by deselecting the 
checkbox “Show this screen each time an image is added.” 
 
You are now returned to the Edit menu and the image is copied to your Respondus Projects 
folder.  
 
If the object you are adding to a question is an audio/video clip, a media object that requires a 
browser plug-in, or an attachment (such as a spreadsheet), a different prompt will appear once the 
file is selected. 
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There are two primary choices to be made on this screen, each of which offers a secondary 
option. The first choice is to determine whether you want the item inserted as a link or as an 
embedded object. For most situations you will want to use the “Linked Object” option, which is 
the default setting. (In HTML terms, this is referred to as an “a href” tag.) The alternative choice 
is to use the “Embedded Object” option, which is sometimes required if your object requires a 
browser plug-in.  
 
If you select the “Linked Object” option and click [OK], the actual file name of the audio/video 
file will display in the link that appears to the student. As an alternative, you can enter a more 
“friendly” description for the link, such as “Click Here to Listen” for an audio file or “Click Here 
to Open the Spreadsheet.”  
 
Similarly, if you select the “Embedded Object” option and click [OK], the size of the player 
window for the object will be determined automatically by the user’s browser. If, however, you 
want to determine the exact size (in pixels) of the media player, you can do so by entering the 
width and height dimensions accordingly. 
 
Once a media object or file attachment has been selected and you return to the Edit menu, a short 
string of characters representing the object will appear in green text. An image placed in the 
question wording will look something like <PIC_1>, with the next image being displayed as 
<PIC_2>, and so on.  An <AV_1> tag will represent other file types. When a media object has 
been placed in an answer choice or feedback, it will appear as a small green box, except when 
that field is being edited.  
 
To delete a media object, position the cursor in the same field where the item is located. Then 
click the “Insert Picture or File” icon on the toolbar (the camera icon) and select the option to 
delete an existing image or file.  
 
You can preview questions containing media objects by selecting the [Preview] button. We 
recommend that you preview all media objects before publishing them to the WebCT server. 
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Web Links 
The Web Link tool, available from the toolbar of the Edit menu, makes it easy to add a link to a 
web page or a media file located on a different web server. This is useful when a media file is 
large or only available from a different web server (such as a web site run by a museum, or a 
content management system).  
 
Upon clicking the Web Link icon on the toolbar, a pop-up window will offer two areas for 
entering a URL. The top section should be used if the link will point to an image (such as a jpeg, 
gif, or png file). The bottom section should be used if the link will point to a web page or an 
audio/video file located on another server.  
 
Links to image files can have a border placed around the image. Links to a web page or 
audio/video file can have text specified for the link displayed to students, such as “Click here to 
watch the video.” This text would then appear instead of the file name or URL itself. 
 
Once a web link has been pasted into the appropriate “Address (URL)” field, click [OK] to return 
to the Edit menu. A short string of characters representing the web link will appear in green text. 
If the HTML web link is placed in the question wording, it will look something like <H_1>, with 
the next link being displayed as <H_2>, and so on. When a web link has been placed in an 
answer choice or feedback field, it will appear as a small green box, except when that field is 
being edited.  
 
A web link can be previewed (if the computer is connected to the Internet) by clicking the 
[Preview] button.  
 
To delete a web link, position the cursor in the field where the web link is located. Then click the 
“Web Link” icon on the toolbar, select the delete option, highlight the link in the list, and click 
[OK].  
 
 
HTML Editor 
Even course designers who are comfortable writing HTML often have difficulty sorting out the 
HTML they’ve written from the question wording itself. Respondus solves this problem by 
encapsulating blocks of HTML so that the question wording stays the focus of the screen. The 
only time a designer has to view HTML is while the Respondus HTML Editor is being used.  
 
From the Edit menu in Respondus, position the cursor at the location in the question where you 
want to begin a block of HTML. Then click the “HTML Editor” icon on the toolbar (represented 
by the symbol <H>) to open the editor. Enter your HTML by typing or pasting it into the editor--
it is also possible to retrieve the HTML from a file located elsewhere on your hard drive by using 
the “Read File” option. Click [OK] to close the HTML Editor. A set of characters representing 
the HTML block will appear at the insertion point: <H_1> for the first block, <H_2> for the 
second block, and so on. To see how the HTML will appear in WebCT, click the preview button. 
 
To delete an HTML block, position the cursor in the same field where the HTML block is 
located, and select the “HTML Editor” icon from the toolbar. Choose the option to delete the 
HTML block and highlight the block you want to delete. Click [OK] to close the HTML Editor.  
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Equation Editor 
The process of adding equations is similar to how media objects are added (see the earlier 
discussion). Equations can be added to question wordings, answer choices and feedback without 
having to write HTML. In addition, the equations can be previewed offline and they are 
automatically uploaded to WebCT during the Publish process.  
 
From the Edit menu, position the cursor at the place in the question where you want the equation 
located. Then click the “Equation Editor” button on the toolbar, which is represented by a 
summation symbol. The Equation Editor will open and you can begin creating the equation. The 
Equation Editor in Respondus works almost identically to the one that is available with Microsoft 
Word and WordPerfect. So if you’ve used those equation editors before, you’ll already know how 
to use this one. The key thing to learn about the Equation Editor is that the top row of menu 
options consist of “symbols” while the bottom row of menu options consist of “palettes”. If you 
select a “symbol” from the top row, it’s no different than if you selected the + or = sign on your 
keyboard -- except that the symbols from the Equation Editor eventually get displayed as graphics 
since they are not HTML-compatible. When you select a “palette” from the bottom row, you are 
given the opportunity to enter text at various insertion points shown on the screen. You can also 
select a palette from the bottom row, click in an insertion point, and then select a symbol from the 
top row. For more information about the Equation Editor, refer to the online help that is available 
from within the editor.  
 
Once you finish editing the equation, exit the Equation Editor by either clicking the [X] that 
appears at the top right corner of the window or by selecting File from the pull-down menu and 
clicking Exit. A second window that addresses other properties of the equation will now appear. 
The font selection and size used within the Equation Editor determines how large the equation 
will be when it is printed from Respondus. But it is generally desirable to show equations in a 
larger format when displaying them on the web. In general, we recommend that a web-based 
equation be displayed at 150% of the size used for printing. So by default, the Respondus 
software suggests that the “WebCT Image Scaling” for the equation be increased to 150%. To 
accept this setting, simply click the [OK] button. If you want the graphic to appear even larger in 
WebCT, then you can increase the scale to up to 400%. It’s important to note that changing the 
image scale using this option only affects how it will appear in WebCT --you are NOT affecting 
the size of the equation that will print from Respondus. In order to change the size of the equation 
for printing purposes, you must select a different font size in the equation editor itself.  
 
An additional “Alt” field allows a text description to be added to the equation image so it can be 
utilized by an ADA-compliant screen reading browser. This text is also displayed when the 
mouse pointer is held over the image. If you simply click [OK] to close the window, the generic 
text “equation” will be used for the “alt” field. If an expanded textual description is entered (such 
as “b is greater than or equal to c”), it will be used by the screen reader instead.  
 
Once an equation has been added and you return to the Edit menu, a short string of characters 
representing the equation object will appear in green text. An equation placed in the question 
wording will look something like <EQ_1>, with the next equation being displayed as <EQ_2>, 
and so on. When an equation is placed in an answer choice or feedback, it will appear as a small 
red box, except when that field is being edited.  
 
To modify or delete an equation, position the cursor in the same field where the equation is 
located. Then click the “Equation Editor” icon on the toolbar and select the option to modify or 
delete an existing equation.  
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You can preview questions containing equations by selecting the [Preview] button. We 
recommend that you preview all equations before publishing them to WebCT. 
 
Using MathType with Respondus 
The Equation Editor in Respondus is a special version of MathTypeTM by Design Science. If you 
frequently create documents with equations, you may find MathType is better suited to your 
needs. MathType is as easy to use as the Equation Editor and has many extra features to help you 
save time and create a wider range of equations.  
 
MathType is available in English, Japanese, German and French. For further information about 
purchasing MathType, contact your software dealer or Design Science directly: Design Science, 
Inc., 4028 Broadway, Long Beach, CA 90803, USA.  
 
 Toll free: 800-827-0685     International: 562-433-0685 
 Fax: 562-433-6969 
 Email: sales@dessci.com 
 World Wide Web: http://www.dessci.com 
 
If you already own MathType, you will need to reinstall it in order to have it work directly with 
Respondus. MathType's readme file explains that it sets itself up to replace Equation Editor at the 
time that it's installed. So if you add a new application like Respondus that uses the Equation 
Editor, you must re-install MathType. 
 
 
Power Edit 
The “Power Edit” task available from the Edit menu provides additional features for formatting 
questions including a table editor, bulleted lists, the ability to change fonts and justification, and 
so forth. In addition, the Power Edit window provides a much larger workspace, which is 
especially useful if you are creating tables or editing questions that have large blocks of text.  
 
To begin, click in the field that you want to edit and then click the “Power Edit” button on the 
toolbar. Several of the tasks on the Power Edit toolbar also appear on the main toolbar, so only 
the unique features will be discussed below.  
 
Tables 
Respondus makes it easy to insert and edit tables. From the Edit menu in Respondus, position the 
cursor at the location where you want to insert the table. Then click the “Power Edit” button and 
select the “Insert Table” icon from the toolbar (located at the top right). When the next pop-up 
window appears, specify the number of columns and rows that should be included in the table (all 
other settings are optional). Click the [OK] button to return to the Power Edit window. You can 
now click within the cells of the table and enter the text.  
 
The width of the table cells can be adjusted by dragging the column lines. To edit other 
dimensions of the table from the Power Edit menu, click within the table and select the desired 
action from the pull-down menu labeled “Table.” Use the “Insert” option to add a row or column 
to the table. Use the “Delete” option to delete a row or column, or to delete the entire table. Other 
formatting (such as font changes and the centering of text) can also be applied to the cells in a 
table. 
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Finally, keep in mind that it is usually possible to paste tables into Respondus directly from 
Microsoft Word. Also, Respondus tables are designed to support both web-based exams and print 
exams. So you only have to create a table once if you require both online and print exams.  
 
Fonts, Formatting, and Lists 
The remaining features in the Power Edit task are self-evident if you are familiar with the basic 
functioning of a word processor. To apply a different font, highlight the text and select the desired 
font and size from the pull-down lists. Text can be left justified (the default), right justified, and 
centered by selecting the appropriate toolbar button. Finally, it is easy to create bulleted or 
numbered lists by selecting the corresponding option from the Power Edit toolbar.  
 
To see how the formatting will appear in WebCT, click the preview button that is located at the 
top left of the Power Edit toolbar. To exit the Power Edit window, simply click the [X] at the top 
right corner of the window, or go to File and click Save & Exit. 
 
 
Spell Check 
The Spell Check feature, which is located on the toolbar for the Edit menu, will search the 
currently open file for spelling errors and allow corrections to be made. Once the Spell Check 
feature is started, it will search for words that do not match items stored in the dictionary. If the 
word is not found in the dictionary, you are given the option to “Change” the word to one that is 
suggested, to “Ignore” the identified word, to “Change All” such words in the file to one you 
select, or to “Add” the word to the dictionary. If you want to make more detailed changes to the 
question, click the “Edit This Question” button, which will close the spell checker and make the 
question available for editing.  
 
Three dictionaries are included with a standard installation of Respondus: American English, 
Canadian English, and British English. However, a free bundle of supplemental dictionaries can 
be downloaded from the Respondus website, including French, German, Spanish, Dutch, Finnish, 
and a comprehensive medical dictionary. 
 
 
Keyword Searches 
There are several places in Respondus where the [Keyword Search] button appears, such as at 
the bottom of the Edit menu. This option allows you to search the currently open file, or the file 
that is being previewed.  
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Up to three words can be included in a search. When more than one word is used, you can choose 
whether a match is required of all words or any of the words. A final option allows you to include 
answer choices and feedback in the keyword search.  
 
 
Modifying, Rearranging, and Deleting Questions 
It is easy to modify, move, or delete a question in Respondus. From the Edit menu, select a 
question from the “Question List” by clicking on its “Title”. A window appears that displays the 
properties for the question. On the right side of the window are several options. Click the [OK] 
button to close the window, click the [Delete] button to delete the question, click [Preview] to 
preview the question, and click [Move] to place the question at a different position in the 
Question List. If you select the [Modify] button, you will be returned to the edit screen and the 
current properties for that question will be displayed in the form--modify the question as you like. 
When modifying an existing question, notice that the two buttons at the bottom of the form now 
indicate “Save Changes” or “Cancel Changes”. To save the changes to the question, select the 
corresponding button. If you do not want the changes to be implemented, select the [Cancel 
Changes] button.  
 
 
Using a Question as the Basis for a New Question 
To use an existing question as the starting point for a new question, locate the question in the 
“Question List” at the bottom of the Edit menu. Select the question by clicking on the title. When 
the properties window appears, select the button [Use as Basis for New Item]. You will be 
returned to the edit screen and the properties for the original question will be displayed in the 
form. The original title for the question will be modified slightly to give it a unique name. At this 
point you can rename the title and make any other changes you like. When finished, add or insert 
the question into the Question List.  
 
 
Copying Questions from Another Respondus File 
From the Edit menu it is possible to copy questions from another Respondus file. Click the button 
[Copy from another file], which is located on the left side of the screen. This will open a 
window containing the files stored in the default directory (\Respondus Projects). Select a 
“source” file by double-clicking the file name or by clicking it once and selecting [Open].  
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Tip: Before selecting a file, you can search the contents of the file by clicking on it once 
and then clicking the [Search] button. You can also preview the questions for a file--
prior to opening it--by highlighting the file name and clicking the “Item List” button.  
Specific information for a question can be obtained by clicking its title. 

 
Once the source file is selected, a new window lists the questions in it. Individual questions can 
be selected by clicking the column furthest to the left. A checkmark will indicate that the question 
has been selected. When the desired questions have been selected, choose either the [Add to End 
of List] button or the [Insert into List] button to add the questions to the original (“target”) file. 
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Settings Menu 
Overview 
Question Sets 
Basic Settings 
Availability Settings 
Security Settings 
Submissions Settings 
Results Settings 
How to Save New Default Settings 

 
 
Overview 
Respondus allows the selection of settings for a quiz or survey prior to it being uploading to 
WebCT. Although this step is entirely optional, it provides the ability to create “question sets” 
and to determine the settings for the quiz offline. It’s even possible to have a quiz activated as 
soon as it is published to the WebCT course.  
 
The “Question Sets” task has an entirely unique approach and design to it than that used by 
WebCT. However, the three other Settings tabs in Respondus are very similar in design to how 
they appear in WebCT. Rather than write an entirely new explanation for how the Settings 
options work in WebCT, we have borrowed (with WebCT’s permission) much of their on-line 
help for this section.  
 
Finally, please note that the discussion below focuses on the settings for quizzes. Some of these 
settings are not relevant to surveys, such as the “Results Settings.” If you are using a survey file, 
only the settings available for WebCT surveys will be displayed.  
 
 
Question Sets 
WebCT supports the creation of “question sets,” which are groupings of questions that are 
randomly selected during an exam. Before creating question sets in Respondus, it is important 
that questions intended for question sets be organized and grouped properly. For example, if the 
fifth question in the exam is going to be randomly selected from a question set having three 
questions, then those three questions should be grouped together at 5, 6, and 7 in the file. Make 
sure your questions are organized in this manner before continuing. 
 
To create a question set, go to the Settings menu and select the “Question Sets” tab.  
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Then select the option “Add New Set” and enter the first and last numbers -- that is, the range -- 
of the questions that will comprise the question set. For instance, if you want questions 5, 6, and 7 
to be the basis of a question set, you would enter 5 as the first question and 7 as the last question 
in the set.  
 
If you want all of the questions in the set to be shown during the exam, select the “All” option. If, 
however, you want a smaller number of questions from the set asked during the exam, choose the 
“Select Number” option and provide the desired number. For example, if you want only one 
question from questions 5-7 asked during the exam, you would enter the number 1. You are then 
asked to provide a point value for the question set. (All questions in a question set must have the 
same point value.) 
 
Finally, click the “Add New Set” button to finish the creation of the question set. In the list 
below, a letter representing the question set will appear next to each question that is contained in 
the question set.  This allows you to easily see which questions are grouped together.  
 
The letters representing each question set also provide the basis for editing a question set. For 
instance, if the letter “C” appears next to a set of questions, and you want to edit this particular 
question set, select the option “Modify or Delete Existing Set” and select “C” from the pull-down 
list. The current settings for that question set will be displayed and several new options will 
appear in the lower section of the screen: Save Changes, Cancel Changes, and Delete Set.  
 
In order for question sets to be included with the quiz when it is published to WebCT, you must 
select the checkbox “Add Question Sets to Quiz” on the Publish to WebCT menu. Conversely, if 
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you do not want question sets included with the quiz when it is published to WebCT, leave this 
box unchecked. 
 
 
Basic Settings 
The section labeled Basic Settings includes settings that must be considered for most quizzes and 
surveys. 
 

 
 
 
Description 
A description of the quiz can be entered. This will be visible to the student at the start of the quiz. 
 
Question Delivery 
There are three options available for question delivery. They are explained in the same order as 
displayed in the graphic above.  
 

• The first option corresponds to the standard option, which is to display all of the 
questions simultaneously on the screen. This method follows the delivery method of a 
paper exam where a student may view and answer questions in any order.  

• The second option provides the same flexibility to the student as option one, but displays 
only one question on the screen at a time.  

• The third option is very different from the first two options. Like the second option, this 
option displays one question at a time; however, students must answer or skip each 
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question before proceeding to the next question. Once a question has been answered or 
skipped, the student cannot revisit the question.  

 
Question Titles 
Select this check box to allow students to see the titles used when the questions were first created.  
 
Quiz Duration (Quizzes only) 
The duration is the length of time the student has to complete the quiz. The clock starts when a 
student first accesses the quiz.  
 
To set the duration for the quiz, select the units (day(s), hour(s), or minute(s)) from the drop-
down menu and then type the number of desired units in the text box. To give students unlimited 
time on a quiz, select the “unlimited” option from the pull-down menu and do not specify any 
units in the text box. 
 
Normally, the student may submit answers after time has expired. All of these events are logged 
so that it is easy to determine which students exceeded the set time limit, and by how much. You 
may set the quiz so that students cannot submit answers after their time is up. To do this, click the 
check box labeled Disallow submission if time has expired. 
 

Warning: Use this feature with caution. This feature will not take into account that a 
student spent 30 minutes composing an answer and then attempted to submit the answer 
after the set time limit; the submission will not be allowed, so all the work will be lost. If 
this function is used, warn the students to save their work frequently by clicking Save 
Answer. 

 
Attempts Allowed (Quizzes only) 
This setting determines the number of times a student may complete a quiz—this may be set from 
one to five, or to unlimited. Select your choice from the drop-down menu. 
 

Note: For the purpose of compiling question statistics, only the first attempt is recorded.  
 
Attempts Separation (Quizzes only)  
For quizzes that allow multiple attempts, you can set a minimum time that the student must wait 
before retaking the test. To set the duration, select the units (day(s), hour(s), or minute(s)) from 
the drop-down menu, and enter the number of units in the text box. If you do not enter a value, 
then there is no waiting period before a student can retake a test.  
 
Randomize Sets 
This is the quickest way to randomize all questions in a quiz. If individual “question sets” are 
created using the “Question Sets” tab on the Settings menu, the order of the question sets will be 
randomized if this checkbox is selected. 
 
 
Availability Settings 
The Availability Settings must be considered for every quiz and survey. These settings describe 
the time period in which the quiz or survey will be available to the students. 
 
Available After 
To set the start point of the quiz/survey availability period, fill in the text boxes for day, month, 
and year, and choose a time from the selection boxes for hour and minute. If any of the values for 
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day, month, and year are zero, then the quiz/survey will not be released. However, if you want to 
activate the quiz/survey as soon as it is published to WebCT, select the option “Allow access as 
soon as the quiz is submitted.” 
 
It is important to remember that the “time” on the server may not match your own time. For 
example, WebCT Inc. uses the Universal Time Code (UTC) for courses that are hosted on their 
servers. If you are not comfortable calculating the difference between your time zone and the 
UTC, you may want to avoid tight time limitations for administering quizzes. Also, remember 
that the UTC doesn’t adjust their clocks for “Daylight Savings” and other time-related events 
used in certain countries.  
 
Available Until 
To set the end point of the quiz/survey availability period, fill in the text boxes for day, month, 
and year, and choose a time from the selection boxes for hour and minute. If any of the values for 
day, month, and year are zero, the quiz availability will be Unlimited.  
 
To make a quiz/survey immediately unavailable, you will need to go to the Quiz Settings section 
in WebCT and select “Deny Access Now”. 
 
Selective Release 
Respondus does not allow you to determine the Selective Release Settings offline. If you want to 
use these settings, you must make the changes in WebCT using your browser. 
 
 
Security Settings 
The Security Settings are optional. They may be used to restrict access to the quiz/survey for 
security purposes. The settings do not change the Availability of the quiz/survey, they only 
change how it is accessed. 
 

 
Proctor Password 
If nothing is entered in the text box, your students may access the quiz normally. Otherwise, your 
students will be asked for a password before entering the quiz. To successfully enter the quiz, the 
password the student enters must exactly match the text in the text box. This method is often used 
with proctored exams given in lab settings, as the exam proctor will give out the password at the 
beginning of the exam. This ensures that the correct students are accessing the quiz at the proper 
time.  
 
IP Address Mask 
In order to limit quiz access to those coming from a specific group of computers, an IP address 
mask may be used. If nothing is entered in the IP Mask Number text box, then all computers can 
access a quiz (if available). In the example illustrated above, a student trying to access the quiz 
from a computer with an IP address of 128.192.64.37 will be allowed access, but a student 
accessing from 128.192.32.39 will not be allowed access, since the 32 from the student's IP 
address does not match the 64 in the IP address mask.  
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Submission Settings 
The Submission Settings are optional. These settings affect the behavior at the time a quiz or 
survey is submitted by the student. 
 
Submission Message 
Any text entered in the text box will be displayed to the student after the quiz or survey has been 
submitted.  
 
E-mail Submissions 
If a valid internet e-mail address is entered in the text box, a text only copy of each student's 
submitted quiz will be sent to the e-mail address.  
 
 
Results Settings (Quizzes only) 
The Results Settings in this section are required for quizzes. These settings affect the behavior of 
a quiz after it has been submitted. 
 

 
 
 
Student Score Release 
This setting is used to set the conditions that will allow a student to view the quiz after it has been 
submitted. Note that when a student views a quiz, this causes it to be graded.  
 
There are three options available for the release of quiz results to your students. 



 48 

 
• The first option releases the quiz results to your students with no restrictions. If the 

quiz includes questions that cannot be marked automatically, the graded quiz will 
only be partially graded when viewed by the student.  

 
• The second option releases the quiz to your students only if all the questions have 

been graded. Thus, if all of the questions in a quiz can be graded automatically, the 
student will be able to view the graded quiz immediately. If the quiz includes 
questions that cannot be graded automatically, then your student can view the graded 
quiz only when all of the questions have been graded.  

 
• The third option does not release the quiz results to the students. Thus, the students 

will not be able to review the quiz after taking it. 
 

Note: These options may be changed at any time in WebCT (using a browser). For 
example, if a quiz includes questions that cannot be graded automatically, it is often 
useful to select option three. Then, once all the quizzes have been fully graded, one of the 
first two options can be selected. Remember that once a quiz has been submitted to 
WebCT and accessed by students, you can no longer use Respondus to make 
modifications or changes to the quiz. This must be done directly in WebCT using a 
browser.  

 
Student Score 
If you allow your students to attempt the quiz multiple times, then this setting will determine how 
WebCT calculates the quiz score. The selection box can be set to use the First, Latest, Highest, or 
Average score to calculate your students' score for a quiz.  
 

Note: Only fully graded quizzes are used in the score calculation. Quizzes that are not 
graded or are partially graded are not included in the calculation.  

 
Note: For question statistics, only the first attempt is recorded.  

 
Results Displayed to Students 
These check boxes determine the amount of quiz information that WebCT will display to a 
student. These settings will not be in effect if you have not released the quiz results. The basic 
parts of each question that can be toggled on and off are: the text of the question itself, the 
feedback for the question, and the student’s score for the question. If the question text is being 
displayed, your student’s response may also be shown. If the response is shown, an evaluation of 
the question may also be shown. For the entire quiz, the total score and any comments entered by 
a grader may be displayed.  
 
The default configuration shows the student everything. To duplicate the appearance of the quiz 
as a student took it, select only option “A”. To show no information about the quiz other than the 
final score, select only option “I”. 
 
Email Results 
The results of the quiz can be emailed to the instructor by entering an email address in this field. 
 
 
How To Save New Default Settings 
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In Respondus there are two types of default settings: the original settings as displayed in WebCT, 
and a second set of default settings that you can determine yourself. To save your own default 
settings, select the options you want across the three setting tabs (Basic & Availability, Security & 
Submissions, and Results). Then click the [Use as New Defaults] button on the left side of the 
screen. From this point forward, all new files created in Respondus will have the new default 
settings attached to them.  
 
If you modify the settings and later wish to restore the default settings (either your own default 
settings or WebCT’s), simply click the [Restore Default Settings] button. You will be asked 
which settings you want to restore.  
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Preview & Publish 
Overview 
Preview 
Publish to WebCT 
Printing an Exam 

 
Overview 
Once an exam or survey is created in Respondus, the Preview and Publish menu let’s you 
determine what to do with the file. Most users will first want to examine the contents of the file 
using the Preview task. When the questions are ready to be uploaded, the Publish to WebCT task 
connects Respondus to a WebCT server and transfers the exam or survey to it. Finally, the Print 
Options task lets you format and print the exam or survey directly from Respondus. This task also 
makes it possible to save a file to Microsoft Word format for further enhancement and printing.  
 
 
Preview 
The Preview task, located on the Preview & Publish menu, is similar to the preview option that 
appears in the Edit menu. The primary difference is that here you can easily scroll from one 
question to the next.  
 

 
 
The preview window shows how the question wording and answer choices will appear to students 
when they take the exam. The feedback and correct answer for the question is additionally 
displayed at the bottom of the window.  
 
To edit the question being displayed in the Preview window, click the [Modify Item] button. The 
screen will change to the Edit menu and the question will be displayed in the editor. Make the 
required changes and click [Save Changes].  



 51 

 
 
Publish to WebCT 
The Publish to WebCT wizard is available from the Preview & Publish menu and it guides a user 
through the steps of publishing a quiz to WebCT. You must already have a WebCT account and 
password in order to use this task. In addition, it is helpful to understand the basic approach used 
by WebCT to create an online quiz.  
 

 
 
The initial decision is to choose if the quiz will be published to a single course/section or to 
multiple courses/sections. (Note: The “Batch Publish” feature is only available in the Campus-
wide version of Respondus.)  
 
The next step requires that information be entered about the WebCT server and the user account. 
(This information can be stored for future use, enabling this step to be bypassed after the initial 
setup.) From the WebCT Server list, select “Add New Server.” A window will open. 
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As instructed on the screen, start a web browser, log into your WebCT course, and go to any 
group, course, or section. Copy the complete URL for this page and paste it in the field provided. 
(The easiest way to copy a URL displayed by a browser is to highlight it with a mouse, click the 
right mouse button, and select “copy.” Then go to the appropriate field in Respondus, click the 
right button again and select “paste.”) 
 
Before proceeding with the next step, make sure your computer has a live Internet 
connection. Then click the “Extract” button. If a connection to the WebCT server is 
unsuccessful, an error message will indicate that Respondus was unable to connect to the server 
using the provided settings. If this occurs, troubleshoot it as follows:  
 

• Make sure you are running a supported version of WebCT and have the correct 
“personality” selected from the Start menu in Respondus. 

 
• Make sure your connection to the Internet is working properly. 
 
• Double-check the designer-level Password and User ID information. In fact, open 

your browser, go to the WebCT server, and enter the identical login information. This 
will confirm that the WebCT server is running and that the User ID and Password are 
correct.  

 
• Make sure you are running the latest version of Respondus (go to Help>Check for 

Update to see if a more current version is available). 
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After Respondus makes the initial connection with the WebCT server, click the “Institutions” 
button and choose your institution from the pull-down list.  
 
Now provide a short description for the WebCT server. The server can be named anything you 
like, such as “My WebCT Server.” If more than one WebCT server will be accessed, you will 
want to select a name that helps differentiate the servers.  
 
Enter a designer-level User Name and Password. This information should be the same as what is 
entered when using a web browser to access a WebCT course. If you want Respondus to 
remember the User Name and Password for future sessions, select the “Remember my User 
Name...” setting. Click [OK] to close the WebCT Server Settings window. 
 
Click [Next] to continue to the next page of the wizard.  
 
Respondus uses the login information to look up the WebCT Groups and Sections that are 
associated with it. Select the group or section to which the quiz/survey will be published. The 
hourglass will appear momentarily as Respondus determines whether additional templates are 
associated with the selected Group or Section. If more than one template is available, select the 
one to be used. 
 
WebCT requires that questions be placed in a “category” (i.e. a question database) before they are 
used in a quiz or survey. So decide whether to create a new category or use an existing one. To 
use an existing category, select the second option and choose a category from the pull-down list. 
All questions in the Respondus file will be appended to this category during the publishing step.  
 
The remaining selections are optional, including the ability to create a quiz (it is possible to 
publish a “category” to WebCT without creating a quiz).   
 
One section allows the creation of a new quiz, the creation of a self-test, or the updating of an 
existing quiz. Select the box for “Create/update quiz” to do any of the three. To create a new quiz 
or self-test, select the appropriate option and provide a name for the quiz or self-test. To update 
an existing quiz, select the third option and pick the quiz from the drop-down box. (If an existing 
quiz is selected, a popup window will ask whether to erase the original questions or to append the 
questions to the existing quiz. Make a selection and click [OK].) 
 
If Question Sets were created for the quiz (see the Settings menu) they will be uploaded if the 
Question Sets option is selected. The selections from the Settings menu can also be uploaded with 
the quiz.  
 
To link the quiz or survey to an organizer page or learning module, select this box. During the 
publishing process, Respondus will prompt you to select the specific page or learning module.  
 
Click [Next] and Respondus will begin publishing the quiz or survey to the WebCT course. A 
status report appears during the publishing process. For a typical quiz, the publishing process 
takes 20-40 seconds. This can increase to five minutes or more if a large number of media files 
are being uploaded or if the server connection is particularly slow. You will know that the publish 
process is complete when the hourglass disappears and the phrase “Completed successfully” 
appears in the “status” window.   
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After an exam is published to WebCT, it is recommended that you go to the course and confirm 
that everything appears as expected. 
 
 
Printing Options 
Respondus allows you to format and print exams/surveys directly from the software. It is also 
possible to save an exam to MS Word format for further enhancement and printing. To begin, go 
to the Preview and Publish menu in Respondus and select the Print Options tab. 
 
The screen now displays the printing options available in Respondus. There are three formatting 
templates from which to select: Exam, Exam with Answer Key, Answer Key Only. Once a 
template is selected, you can further modify it by clicking the Settings button to its right. If the 
exam being printed has matching questions, be sure to select the checkbox labeled "Matching, 
randomize answers" if you want the second set of answers to be randomized. Also, if you have 
sequential questions that refer to the same image or graphic, you will likely want to select the 
“Suppress Repeated Images” button so that the image is not repeated with each question. 
 
Click the [Edit Headers] button to enter the information you want to appear at the top of each 
page. Different information can be entered for the second and subsequent pages too. The header 
information might look something as follows: 
 

 
 
The next section allows up to 5 variations of the exam to be generated. You have the ability to 
“randomize all” questions in the exam or to have the questions randomized according to question 
type (i.e., all the multiple choice questions are randomized within a group, all the essay questions 
are randomized within a second group, and so forth). If Calculated questions are contained in the 
file, each Exam Variation will have a unique set of variables for the calculated questions. If you 
don’t want multiple exam variations, simply retain the “Original Order” option from the pull-
down list.  (Note: As long as the questions in the exam file remain unchanged, a particular “Exam 
Variation” will have the same question order each time it is printed or saved to MS Word format. 
However, if you add or insert new questions, the Exam Variation will differ the next time you 
print/save an exam or answer key.) 
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It is also possible to specify a range of questions to be included in the printed exam. If both fields 
are left blank, all questions will be included.  
 
At the bottom of the screen there are three options: Print Preview, Save to File, and Send to 
Printer. The Print Preview button allows you to preview the contents of the file in a pop-up 
window. We recommend that you use this option before printing the exam/survey or saving the 
contents to a file--it is a quick way to identify mistakes. The Save to File option allows the 
creation of a MS Word file (.doc), a “rich text file” (.rtf), or a standard text file (.txt). The MS 
Word and .rtf formats will retain enhanced formatting such as bold, italics, and underlining, 
whereas the .txt format will strip such information. Once a file is saved, it can be opened with a 
word processor for further formatting and modification. Finally, the Send to Printer option 
permits you to print directly from Respondus. This task works similar to the printing function in 
other Windows programs.  
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Retrieval and Reports 
 Overview 
 Retrieving Reports for Quizzes/Surveys 
 Downloading Data from Quizzes/Surveys 
 Retrieving a Quiz or Category from WebCT 
 
Overview 
Once a quiz or survey is administered in WebCT, Respondus allows you to retrieve reports that 
contain such things as student scores, the grading status, summary statistics, and answer 
distributions. You can also download the database that contains the answers provided by students. 
The final option on the Retrieval and Reports menu allows the retrieval of the quiz/survey 
instrument from WebCT so that it can be modified in Respondus, published to another course, or 
archived. 
 
 
Retrieving Reports for Quizzes/Surveys 
WebCT can generate a variety of reports for quizzes and surveys. Respondus enhances these 
capabilities by retrieving reports from multiple locations in WebCT and consolidating them into a 
single page. Since these reports are automatically saved to the hard drive, it is possible to view 
results offline or to archive the reports at the conclusion of a course.  
 
To retrieve a report using Respondus, go to the Retrieval and Reports menu and select the 
Retrieve Reports tab. The first several steps are similar to those used for publishing a quiz to 
WebCT (see the earlier discussion for a detailed explanation). First select the WebCT Server, 
Group/Section, and template. Then select the quiz or survey for which you want the report.  
 
Three different elements can be included in a report. The first checkbox will retrieve the student 
scores, grading status, and related information (for a survey it will simply list those who have and 
haven’t taken the survey). The table is identical to the one you can obtain in WebCT by selecting 
the "Submissions" option.   
 
The second checkbox allows you to retrieve summary statistics for each quiz question (this option 
is dimmed if you are obtaining reports for a survey). The table is identical to the one you can 
obtain in WebCT by selecting the “Summary” option.  
 
Summary Statistics 

%Correct Of: Score Title N 
Whole Group Upper 25% Lower 25% 

Discri- 
mination Mean SD 

Intervening Variables 11 72 100 0 0.91 72.7% 46.7 
Cross-case comparability 11 45 100 0 0.60 45.5% 52.2 
Creating an index 11 63 100 0 0.80 63.6% 50.5 
Antecedent variables 11 100 100 100 0.00 100.0% 0.0 
     Overall Mean 70.5%  
 
 
The third and final checkbox allows you to retrieve answer distributions for each question. Be 
forewarned that it can take a long time to generate this part of the report--anywhere from 20 
seconds for a short quiz to 30 minutes for a quiz with over 150 questions. However, if these 
statistics are of interest to you, it will be considerably faster to obtain this information using 
Respondus than to manually generate a comparable report for each question within WebCT. The 
report will contain the following information for each question:  
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Question: Intervening Variables 
 
       Answer      Value  Frequency Distribution 

1 0%  3   +++++++++++ 
 2 0%  0 
 3 0%  3   +++++++++++ 
 4 100%  5   ++++++++++++++++++++ 
 
 
All reports are formatted in HTML. Your web browser will automatically open and display the 
report once it is generated. The report is also saved to your hard drive and can generally be found 
in the following folder: c:\Respondus Projects\Reports.  
 
 
Downloading Data from Quizzes/Surveys 
Respondus will download answer databases for quizzes or surveys. The results are saved as 
“comma separated values” files (.csv) which are easily opened by Excel, Access and many 
statistical analysis programs. The download feature in Respondus is especially useful with 
surveys since additional analyses (e.g., crosstabs) are usually desired.   
 
To download an answer database, go to the Retrieval and Reports menu in Respondus and select 
the Download Data tab. The first several steps are similar to those used for publishing a quiz to 
WebCT (see the earlier discussion for a detailed explanation). First select the WebCT Server and 
the Course. Then select the quiz or survey for which you want to download the answer database.  
 
You are now prompted to provide a name for the database that will be downloaded (the file 
extension “.csv” will automatically be added to the file name). If you want to download the file to 
a folder other than “c:\My Documents” use the [Browse] button to identify the folder and to enter 
the name of the file.  Click the [Retrieve] button to begin the download process. Be forewarned 
that the download process can take anywhere from 30 seconds to 30 minutes, depending on 
number of questions in the quiz/survey, the number of students or respondents, and the speed 
with which the server can communicate with Respondus. Once the file is downloaded, open the 
spreadsheet or database program of your choice and locate the file that was downloaded.  
 
 
Retrieving a Quiz or Category from WebCT 
Respondus allows the retrieval of quizzes, surveys, and “categories” from a WebCT course. To 
begin, go to the Retrieval and Reports menu in Respondus and select Retrieve Questions. The 
first couple of steps of retrieving a quiz/survey or category are identical to those used for 
publishing a quiz to WebCT (see the earlier discussion for a detailed explanation). That is, 
provide the WebCT server information, select a group or section from the drop-down list, and 
select the template. Then select either the “quiz/survey/self-test” or “category” option and choose 
the file to be retrieved from the drop-down list. Finally, enter a name for the new Respondus file 
being created and click the [Retrieve] button.  
 
The retrieval process will take between 15 seconds and several minutes depending on several 
factors: the speed of your connection, the load on the server, the size of the media elements that 
are being retrieved, and so forth. You will know that the retrieval is successful by the statement 
“Successfully completed” that appears in the status box.  
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When a file is being retrieved, Respondus will detect if media objects are associated with it and 
will automatically download these objects if they are stored with your WebCT course. 
(Respondus does NOT attempt to download media elements if they are stored on a different 
server.) If media objects are retrieved with a file, Respondus will automatically update the HTML 
links that point to these objects. This makes the media elements work properly when the file is 
published again to WebCT.  
 
Equations that were published to WebCT from Respondus and later downloaded from WebCT to 
Respondus will be treated as “images” from that point forward, not equations. This means that if 
you want to use Respondus to modify an equation that was retrieved from WebCT, you will first 
need to delete the equation graphic using the “Insert Picture or File” option (see the discussion for 
that task) and then use the Equation Editor to create the new equation. Hence, it is better to retain 
the original Respondus file since it permits future editing of equations. Also, if you provide a 
colleague a quiz that contains equations, it is better to send that file in the original Respondus 
format so the person can edit the equations more easily.  
 
Note that Respondus will retrieve “combination questions” although they cannot be edited in 
Respondus. If a WebCT quiz contains question sets, Respondus will maintain these sets during 
the download.  
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Other Tools & Features 
Overview 
Save As Copy 
Preferences 
Question Title Tool 
Check for Update 

 
Overview 
There are several additional tools in Respondus that offer a range of functions. Each of these is 
discussed below. 
 
 
Save As Copy 
The “Save As Copy” tool is located on the File pull-down menu. Use this task to create a copy of 
the currently open file. 
 
 
Preferences 
A “preferences” option, which is located on the File menu bar, contains three tabs: General, Edit 
& Publish, and Conversions.  
 
The first item in General preferences determines whether Respondus will automatically check for 
product updates. (The checking occurs when an exam is published from Respondus to an online 
course.) Directly beneath this is a list of course management systems. If you only want to be 
informed of updates that relate to specific course management systems, unselect those systems for 
which you are not interested. The final option on the General tab allows the current description of 
the Respondus file to be edited.  
 
The Edit and Publish preferences provide a variety of options: 
 

• The ability to discard font changes when copying and pasting from another program 
• The ability to change the default point value for new questions that are created or 

imported 
• The ability to prevent the “ALT text” window (for entering text for screen readers) from 

appearing each time an image is added to an exam 
• The scaling percentage that should be used for equations that are published to WebCT 
• The ability to change the default font for questions that are published to WebCT. (We 

highly recommend that you don’t change the default font. If you change the default font 
and later need to edit your questions from within WebCT using a browser, it will be more 
difficult because the font HTML will be intermixed with the question wording. Also note 
that changes to the default font will not be applied to tables or any text that already has a 
specific font applied it.)  

• Changing the “randomize” setting for multiple choice and multiple response questions in 
Edit. 

 
The third preference tab, Conversions, determines the settings for files converted from one CMS 
personality to another. If you do not want to be asked each time how certain issues should be 
handled for the file conversion, then select the preferred settings.  
 
 
Question Title Tool 
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There are many situations when it is desirable to rename all the titles in the Respondus file to 
provide a consistent look or numbering sequence. For example, if questions are copied or 
imported from a variety of sources the resulting titles may look inconsistent and haphazard.  
 
The Question Title Tool, located under File on the menu bar, lets a “stem” (or prefix) be specified 
for question titles. Consecutive numbering will automatically be generated for the text that 
appears after the stem, beginning with 1 (or 01, or 001, etc.). For example, if you enter 
“Chapter1-” as the stem text, and then select “001” as the format for the numbering scheme, the 
title for the first question will be changed to Chapter1-001, the title for the second question will 
be changed to Chapter1-002, and so on. If a range is specified for the titles being changed, even 
more specific titles can be provided throughout the file. For instance, questions 1-20 might use 
the stem “Ch1-Unit1-” and questions 21-30 might use the stem “Ch1-Unit2-” and so forth. 
 
Check for Update 
The “Check for Update” tool, located on the Help drop-down menu, provides an easy way to see 
if an update is available for Respondus (a live Internet connection is required). Respondus will 
instantly return a message indicating whether an upgrade is available. If an upgrade to Respondus 
is available, you can let Respondus download the required file(s) automatically and update the 
software for you. This is the easiest way to apply a patch or upgrade. 
 
Depending on your preference settings, Respondus will automatically check for an update at the 
time an exam is published to WebCT (this check will occur only once in a 24-hour period). No 
information about your computer hardware and software is collected by Respondus, Inc. during 
this process. Instead, the Respondus software retrieves information from www.respondus.com 
and will display a message if an update is available. You will then have the choice of upgrading 
to the latest version of software.  
 
If you don’t want Respondus to automatically check for software updates during the publishing 
step, go to the File menu, select Preferences, and deselect the appropriate checkbox on the 
General tab.  
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Disclaimer of Warranty   
While Respondus, Inc. has tried to ensure the dependability of the software and documentation, it 
is provided "as is" without warranty of any kind.  Agents of the supplier may have made 
statements about this software.  Any such statements do not constitute warranties and shall not be 
relied on by individuals in deciding to use the program.   
 
Because of the diversity of conditions and hardware under which this program may be used, no 
warranty of fitness for a particular purpose is offered. Test the program thoroughly before relying 
on it. You assume the entire risk of using the program. Respondus, Inc. shall not be liable for any 
expense, claim, liability, loss, or damage (including any incidental or consequential damage), loss 
of profits, loss of reputation, or any loss whatever direct or indirect, by you from either the use of 
or the inability to use the software.  
 
 
Copyright, Ownership, and Use of Software   
All software, with exception of Equation Editor by Design Science and the Sentry Spelling-
Checker Engine by Wintertree Software, remains the property of Respondus, Inc. The software 
and written materials are copyrighted.  This license is not a sale of the original software or any 
copy.  You own the physical media on which the software is originally or subsequently encoded, 
but Respondus Inc. retains title and ownership of the software on all media.  
 
You are not permitted to install the executable code version of this product on a network server or 
virtual server. You may not customize the Respondus “Product.” Except as otherwise permitted 
by written consent, you may not: (i) modify or create any derivative works of the Product or 
documentation, including translation or localization; (ii) decompile, disassemble, reverse 
engineer, or otherwise attempt to derive the source code for the Product; (iii) redistribute, 
encumber, sell, rent, lease, sublicense, or otherwise transfer rights to the Product; or, (iv) remove 
or alter any trademark, logo, copyright or other proprietary notices, legends, symbols or labels in 
the Product. 
 
 
© 2000-2005 by Respondus, Inc. All Rights reserved. The Equation Editor and documentation 
are copyrighted by Design Science, Inc. The Sentry Spelling-Checker Engine is copyrighted by 
Wintertree Software, Inc. 
 
Respondus is a registered trademark and StudyMate is a trademark of Respondus, Inc. 
ANGEL|LMS and ANGEL Learning are trademarks of ANGEL Learning. Blackboard Learning 
System is a registered trademark of Blackboard, Inc. WebCT is a registered trademark of WebCT, 
Inc. eCollege is a service mark of eCollege. Design Science and MathType are registered 
trademarks of Design Science, Inc. Microsoft, MS Word, Excel, and Windows are registered 
trademarks of Microsoft Corporation. All other trademarks are the property of their respective 
owners. 
 


